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About this Manual
The viewLinc 4.0 Administrator Guide includes the 
information you need to install, configure and operate the 
viewLinc system.

You can also view the Quick Start Guide for a graphical 
overview of installing viewLinc. If you are not an 
Administrator, refer to the User Guide for information on the 
standard tasks performed using viewLinc.

Who this Manual is for
This manual is for administrators who will install and 
configure viewLinc Server software and its associated 
components to allow end users to view and monitor device 
readings across a network. This manual covers several 
topics, including how administrators set threshold alarms, 
configure email alarm notification, organize locations, define 
reports, and set device data transfer schedules.

How this Manual is Organized
The viewLinc 4.0 Administrator Guide is organized into 
chapters as follows:

Chapter 1: Getting Started. Contains viewLinc overview, 
hardware and software requirements, essential installation 
instructions, how to log in.

Chapter 2: Management. Includes information about how to 
configure and work with Locations Manager, Views Manager, 
Dashboard Manager, and Device Manager.

Chapter 3:  System Settings. Includes information 
specifically for administrators, including how to create user 
accounts, configure email server settings for alarms, choose 
temperature units to display, and change how and which 
devices are shown in Locations.

Chapter 4: Locations. Covers what a Location is, creating 
Locations, opening large popup trend views, and organizing 
Locations into zones. This chapter covers topics of interest to 
both a general viewLinc user and the administrator.

Chapter 5: Alarms. Contains information on creating, 
editing, deactivating, and pausing alarms informing those 



About this Manual

vi © 2012 Vaisala Canada Inc

monitoring the system of threshold-exceeding conditions or if 
data communication between the device and the system is 
down. Includes how to acknowledge alarms.

Chapter 6: Permissions. Includes information about User 
Permissions, User Rights and Access control lists. Shows 
how to create users, assign them to groups and zones, add 
permissions and control rights.

Chapter 7: Events. Includes filtering and printing event logs, 
including details on transfers, alarms, and 
acknowledgements.

Chapter 8: Reports. Includes a definition of historical data, 
what you can do with it, how to generate reports.

Chapter 9:  Transfers. Includes information about how to 
transfer Vaisala Veriteq device data to a PC for analysis 
using vLog.

Chapter 10: Mobile UI. Includes information about 
viewLinc’s Mobile application and its interface. 

Appendix: FAQs & Troubleshooting. Answers common 
troubleshooting questions, including how to stop and start the 
viewLinc service, what is installed with viewLinc, and how to 
resolve common issues.

Conventions Used in this Document
This document uses the following conventions:

• A sequence of actions is indicated by a list separated by a 
vertical line. For example:

“In viewLinc, choose Options | System Configuration | 
Locations Manager”

• Menu selections, items you select, and the names of 
buttons are shown in bold.

• Keys on the keyboard are shown in [square brackets].

Related Documentation and Software Products
For help with viewLinc, consult the viewLinc Quick Start 
Guide.
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Use vLog software and its associated Quick Start Guide for 
setting up Vaisala Veriteq devices and viewing and printing 
device historical data as graphs or text files.

Use your specific Vaisala product User Guide for information 
about installing 300 Series Transmitters.

Support Information
In North America, technical support is available between 
8am-4pm PST Monday - Friday, 1-866-861-3388 (or 604-
273-6850). You can also email veriteqsupport@vaisala.com, 
or visit www.vaisala.com/lifescience-hitech.

For sales, pricing, quotations, or general information, please 
call 1-800-683-8374 (in North America), or 604-273-6850.

For assistance outside North America, see “Getting Help” on 
page 18.
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Chapter 1: Getting Started

This section includes:

• Overview of the Vaisala Veriteq Continuous Monitoring 
System (CMS)

• Administrator’s Road Map

• What’s New in viewLinc 4.0

• System Requirements, Hardware and Software 

• Installing viewLinc

• Logging in to viewLinc from an Internet Browser to Monitor 
Conditions

• First Steps in viewLinc

• What’s New in viewLinc 4.0

• Getting Help
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Overview
Welcome to viewLinc 4.0, a key element in the Vaisala 
Veriteq Continuous Monitoring System (CMS). Using 
viewLinc you can easily monitor device readings locally on a 
PC or across a network using a supported version of 
Microsoft® Internet Explorer® or Mozilla® Firefox® Internet 

browser, or from mobile devices like the iPhone®, Google 

Android®, or Blackberry®.  

With viewLinc 4.0, you can:

• Monitor remote conditions from multiple devices from a 
local or remote PC desktop

• View real-time data in a customizable graphical format 

• Generate historical data and alarm reports

• Receive visual or email alarms when conditions you are 
monitoring are out of compliance or if there is a network 
communication problem

• Analyze automatically documented device events, such as 
when alarms are triggered, acknowledged or there are 
device communication problems

• Schedule transfers of Vaisala Veriteq device data (also 
referred to as ‘historical data’) to be viewed and graphed 
with the vLog software

• Easily identify devices and the zones in which they 
operate

• Swap a device for calibration or replacement purposes 
without breaking the data audit trail

• Create preconfigured comments for alarm notifications

• Create reusable alarm templates

When installed, the Vaisala Veriteq CMS is comprised of 
software components (including viewLinc), and hardware 
components (including devices, a PC with a supported 
Internet browser, and, depending on how you connect the 
devices to your PC, various cables, Vaisala Veriteq vNet or 
Digi networking devices).

How you connect your devices to your PC is a very important 
administrative decision. There are four methods and each 
requires certain hardware connections. The most convenient 
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methods of attaching devices to PCs are using vNet or Digi 
devices. These options are described in Table 1. 

Method How Connected Detail

vNet devices Ethernet • Allows devices to be con-
nected to the PC across an 
Ethernet network, allowing 
the PC and devices to be 
separated by large dis-
tances within a facility

• Requires installation of 
vNet drivers (provided)

• Requires use of vNet device

Digi device Ethernet • Allows devices to be con-
nected to the PC across an 
Ethernet network, allowing 
the PC and devices to be 
separated by large dis-
tances within a facility

• Requires installation of Digi 
drivers (provided)

• Requires use of Digi device

USB port Vaisala Veriteq 
USB cable

• Allows devices to connect 
directly or over an Ethernet 
network (when device host 
is installed) to the viewLinc 
server

• Requires installation of USB 
drivers (provided) and uses 
a USB connection on a PC

• Requires a USB to logger 
cable

Table 1: Methods of attaching devices to PCs
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It is also possible to use a mix of these methods if your 
system requires it. 

The outlined Administrator’s Road Map applies to all 
installation options.

Administrator’s Road Map
Once your viewLinc system is installed, you may find the 
following roadmap a useful overview of the setup and 
configuration activities required to implement viewLinc. 

1 Edit Vaisala Veriteq device properties using vLog. (such 
as sample timing and device channels - see vLog user 
guide for details)

2 If you plan to set day and time schedules during which 
specific users will be notified of alarms, set Contact 
Schedules (see “About Contact Schedules” on page 53)

3 Create User Accounts (see “Editing Users and 
Passwords” on page 54)

4 Choose temperature measurement unit preferences (see 
“Choosing Temperature Measurement Unit Preferences” 
on page 56)

5 Configure Email settings (see “Configuring Email 
Settings” on page 49)

6 Create Zones, assign Locations to Zones and edit 
Location properties (see “Organizing Locations into 
Zones” on page 28)

Serial port Vaisala Veriteq 
serial port cable

• Allows devices to connect 
directly or over an Ethernet 
network (when device host 
is installed) to the viewLinc 
server

• Requires a Serial port on a 
PC

• Requires a Serial to Logger 
cable

Method How Connected Detail

Table 1: Methods of attaching devices to PCs
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7 Edit Alarm email templates (see “Editing Alarm Email 
Templates” on page 50)

8 Create Alarm and Threshold Templates (see “Creating 
Alarm Templates” on page 80)

9 Add Devices (see “Adding Devices” on page 40)

10 Set and configure Alarm Thresholds (see “Threshold 
Alarms” on page 86)

11 Configure Alarms (see the sections on setting threshold, 
communication and device alarms in Chapter 5: Alarms)

Once these set up activities are complete, you are ready to 
start monitoring device readings, viewing events and printing 
reports. You can also set up transfer schedules to view and 
analyze Vaisala Veriteq device data in the vLog software (see 
“About Transfers and Transfer Schedules” on page 126)

System Requirements
To install viewLinc, you need:   

• Vaisala Veriteq loggers or Vaisala 300 Series Transmitters 
(both are referred to as ‘devices’ in this guide and in 
viewLinc)

• PC (will be referred to in the rest of this document as the 
viewLinc Server)

• Vaisala Veriteq cables (there are specific cables for 
attaching devices to Digi devices and attaching devices to 
USB or Serial ports on a viewLinc Server)

• (optional) vNet devices, for connecting devices to a 
viewLinc Server using an Ethernet connection

• (optional) Digi devices, for connecting devices to viewLinc 
Server using an Ethernet connection
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viewLinc Server Requirements

The viewLinc Server machine must meet the following 
requirements:

• Be available 24 hours a day, 7 days a week.

• Have 350 MB free application disc space.

• Use one of the following operating systems:

• Microsoft® Windows XP 

• Microsoft® Windows Server 2003 or Windows Server 
2008 (32 or 64 bit versions)

• Other operating systems can be used depending on the 
size of the installation

• If you plan to use viewLinc from the viewLinc Server 
machine, you must have a supported Internet browser 
installed (Microsoft® Internet Explorer® 6.0 or later; 

Mozilla® Firefox® 3.6 or later are recommended).

• The Historical database requires 200KB per location per 
day. The default location for the application is in the 
'program files' folder. The historical database and 
configuration files are located 'public documents' folder. 
The default locations of the database are as follows:

Windows 2008/Windows Vista x64

Program files: C:\Program Files(x86)\Vaisala\Vaisala Veriteq 
viewLinc

Data files: C:\Users\Public\Documents\Vaisala\Vaisala 
Veriteq viewLinc 

Windows 2003/Windows Vista x32

Program files: C:\Program Files\Vaisala\Vaisala Veriteq 
viewLinc

Data files: C:\Users\Public\Documents\Vaisala\Vaisala 
Veriteq viewLinc 

Windows XP x64

Program files: C:\Program Files (x86)\Vaisala\Vaisala Veriteq 
viewLinc

Data files: C:\Documents and Settings\All 
Users\Documents\Vaisala\Vaisala Veriteq viewLinc
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Windows XP/2003 x32

Program files: C:\Program Files\Vaisala\Vaisala Veriteq 
viewLinc  

Data files: C:\Documents and Settings\All 
Users\Documents\Vaisala\Vaisala Veriteq viewLinc

Note: It is strongly recommended to use the default 
installation folders for data files as other folders 
may have special security restrictions placed on 
them.  For example, Windows 7/2008 does not 
allow files in the ‘Program Files’ folders to be 
deleted by non-admin users.

Depending on the number of channels you are using, the 
viewLinc Server machine should also meet the following 
requirements:

Large size installation (400-5000 channels)

• a dedicated machine

• 3.2 GHz, Quad Core

• 4 GB RAM

• sufficient HD space to support 200KB/channel/day 

For example, if you have 400 channels, you will need 
approximately 30GB (400x200x365) per year.

Medium size installation (20-400 channels)

• machine may be shared with other applications

• 1.6 GHz Dual Core

• 4 GB RAM

• sufficient HD space to support 200KB/channel/day 

For example, if you have 40 channels, you will need 
approximately 3GB (40x200x365) per year.

Small installation (<20 channels)

• 1.6 GHz

• 2 GB RAM

• sufficient HD space to support 200KB/channel/day 

For example, if you have 4 channels, you will need 
approximately 300MB (4x200x365) per year.
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End User PC Requirements

A machine on the network used to administer viewLinc must 
have:

• 2.4 GHz

• 2 GB RAM

• a supported Internet browser installed (Microsoft Internet 
Explorer 6.0 or later; Mozilla Firefox 3.5 or later 
recommended). 

Installing viewLinc
This section outlines how to install viewLinc on a server or a 
remote host, including a description of the four methods by 
which devices can be connected to the system. The four 
methods are: 

• using a vNet device to connect devices to the network

• using a Digi device to connect devices to the network

• using USB port to connect devices to viewLinc Server or 
Remote Host

• using Serial port to connect devices to viewLinc Server or 
Remote Host

If you are connecting 300 Series Transmitter devices, they 
are connected either wirelessly or using a Digi device. Refer 
to your Vaisala product User Guide for more information.

For further graphical representation of installing viewLinc, 
see the relevant Vaisala Quick Start Guides. There are 
versions for those using vNet or Digi devices and those using 
USB/Serial ports. For copies of Quick Start Guides, see 
www.vaisala.com/lifescience-hitech or speak to your sales 
representative.

Connecting Devices 
Choose from the following methods to connect your devices 
to the network or appropriate PCs. 
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Method 1: Using vNet Devices

The following procedure shows how to use vNet devices to 
connect your devices to the network.

Attaching Main Hardware

1 Remove protective label on the bottom of the device.

2 Connect the device to the vNet device.

3 Connect the vNet device to the Ethernet outlet and (if not 
using PoE) power supply. When power is supplied to the 
vNet device, the red power LED light will blink for 7-8 
seconds, then stay solid. When a network connection is 
made, the red LNK LED should light up and stay solid, 
and the green ACT LED should blink occasionally.
Note: To ensure a secure connection, insert the power 

supply barrel-end connector into the device and 
turn 1/4 to the right. If your network supports 
Power Over Ethernet, you do not need to con-
nect to a power supply.

For more information about installing vNet devices, refer to 
the vNet User Guide.

Installing Vaisala Veriteq Drivers

This section covers installing the drivers for vNet devices to 
connect Vaisala Veriteq devices to the network using an 
Ethernet connection. Repeat all of these steps for each vNet 
device you want to use.

Figure 1: Overview of viewLinc system using vNet devices
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Discovering the vNet Device 

1 Obtain a reserved (recommended) or static IP address 
for your vNet device from your IT department. If your 
networking policy requires you to reserve IP addresses 
using DHCP, see www.vaisala.com/lifescience-hitech for 
instructions.

2 Insert the vNet Device driver CD into the viewLinc 
Server.

3 The Device Setup Wizard launches automatically. Click 
Next.

4 Select the device that matches the MAC address from 
the side of your vNet device, then click Next.

Note: If your device is on a different subnet from the 
server, you will need to know the IP address 
of the vNet device and launch the RealPort- 
Setup.exe installer from the RealPort folder on 
the vNet Device Drivers CD.

Configuring RealPort and Installing Drivers

1 In the Configure Network Settings screen, enter an IP 
address (provided by your IT department). Click Next two 
times.

2 In the Configure RealPort Settings screen, select Install 
RealPort on this computer, then click Next. 

3 Click Next again. The settings are saved.

4 Click Finish.

Repeat Installing Vaisala Veriteq Drivers for each vNet 
device.
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Method 2: Using Digi Devices

The following procedure shows how to use Digi devices to 
connect your Vaisala Veriteq devices to the network.

Attaching Main Hardware

1 Connect your Vaisala Veriteq device to a Digi device 
using a Vaisala Veriteq cable.

2 Connect your Digi device to power supply and Ethernet 
outlet.
Note: These instructions focus on the Digi One SP. For 

other Digi models, see www.vaisala.com/life-
science-hitech.

Installing Digi Drivers

This section covers installing the drivers for Digi devices to 
connect Vaisala Veriteq devices or Vaisala 300 Series 
Transmitters to the network using an Ethernet connection. 
Repeat all of these steps for each Digi device you’ll use.

Discovering the Digi Device 

1 Obtain a reserved (recommended) or static IP address 
for your Digi device from your IT department. If your 
networking policy requires you to reserve IP addresses 
using DHCP, see www.vaisala.com/lifescience-hitech for 
instructions.

Figure 2: Overview of viewLinc system using Digi devices

http://www.vaisala.com/en/lifesciencehightech/Pages/default.aspx
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2 Insert the Digi driver CD into viewLinc Server.

3 The Digi Device Setup Wizard launches automatically. 
Click Next.

4 Select the device that matches the MAC address from 
the bottom of your Digi device. Click Next.

Note: If your device is on a different subnet from the 
server, you will need to know the IP address of 
the Digi device and launch the RealPort installer 
on the Digi Driver CD.

Configuring RealPort and Installing Drivers

1 In the Configure Network Settings screen, enter an IP 
address (provided by your IT department). Click Next two 
times.

2 In the Configure RealPort Settings screen, select “Install 
Digi RealPort on this computer”. Click Next. 

3 Click Next again. The settings are saved.

4 Click Finish.

Repeat Installing Digi Drivers for each Digi device. 

Method 3: Using USB Port

You can also connect Vaisala Veriteq devices directly to PCs 
using a USB Port, as shown in Figure 3.

Figure 3: Overview of viewLinc system using USB port to connect devices
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Installing USB Drivers

 Using the supplied Vaisala Veriteq USB cable driver CD 
and Quick Start guide, install USB drivers on every PC 
you plan to attach devices to.

Connecting Hardware

1 Connect the device to a Vaisala Veriteq USB cable.

2 Connect the USB cable to your viewLinc Server or 
Device Host (ensure the viewLinc Server computer is 
attached to your network).

3 Install a USB cable driver. You only need to install a 
driver once on each machine to which devices are 
connected.  

Method 4: Using Serial Port

You can also connect devices to PCs using a Serial Port. The 
configuration using a Serial port is very similar to using USB; 
refer to Figure 3. 

Connecting Hardware

1 Connect your device to a Vaisala Veriteq Serial port 
cable.

2 Connect the Serial port cable to your viewLinc Server or 
Host (ensure this computer is attached to your network).

Repeat these steps for all devices.

Installing vLog Software 
Once your devices are installed, you are ready to install vLog 
software. 

Note: If you use 300 SeriesTransmitters, you are not 
required to install vLog Software.

Installing vLog allows you to:

• set sample intervals

• enable or disable channels

• specify device and channel descriptions

• store historical data for backup purposes 

It is recommended you install vLog on all PCs with Vaisala 
Veriteq devices connected to them. 
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Refer to the vLog User Guide for installation instructions.

Installing viewLinc Software
Now you are ready to install viewLinc which will be used to 
make device monitoring, alarming and reporting available 
across your network. There are two options available to you:

• Install viewLinc software on a network server (must be 
installed once).

• Install viewLinc software on a PC as an offsite host to 
make devices connected to it available to the viewLinc 
server. 

To install viewLinc on the viewLinc Server:

1 On your viewLinc Server, insert the viewLinc CD and run 
setup.exe.

2 Select the installation language using the dropdown. 
Click OK.

3 Start the Setup Wizard by clicking Next.

4 Review and accept the License Agreement, and click 
Next.

5 Choose a destination location for the viewLinc program 
files, then click Next.

6 Select Enterprise Server from the Select Components 
screen and click Next.

Enter the installation key purchased from Vaisala.

Select Non-secure, Secure server (SSL) or Both.

7 Review the install options and click Install.

8 Click Finish once the application is finished installing.

You can set up additional computers as remote hosts using a 
USB or Serial cable.

To install viewLinc on an offsite host PC:

1 Insert viewLinc CD and run setup.exe.

2 Select the installation language using the dropdown. 
Click OK.

3 Start the Setup Wizard by clicking Next.

4 Review and accept the License Agreement, then click 
Next.
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5 Choose a destination location for the viewLinc program 
files, then click Next.

6 Select Logger Host, then click Next. 

7 Click Install.

8 Click Finish. 

You have installed all necessary viewLinc components.You 
can now move to any machine on the network - or stay where 
you are - and log in to viewLinc to monitor channels using 
any supported Internet browser on the network.

Logging in to viewLinc
viewLinc allows you to:

• watch conditions (such as temperature and relative 
humidity) being recorded by devices and in the viewLinc 
historical database

• receive alarms if conditions are outside limits you set or if 
there is a communications problem

• receive other system-related alarms 

When you are ready to start using viewLinc,  such as setting 
alarms, configuring email settings, and scheduling device 
data transfers, log in to viewLinc from a supported Internet 
browser. Supported Internet browsers include .

By default, one administrator account is created when 
viewLinc is installed. The username and password are both 
“admin”. It is important you change the admin password as 
soon as possible to prevent unauthorized access (see 
“Editing Users and Passwords” on page 54). 

To log in to viewLinc:

1 Double-click the desktop icon .

2 Or, in the address box of a supported Internet browser, 
enter the name or address of the machine where 
viewLinc is installed, and the port number. For example, 
http://computername:portnumber or https://
computername:portnumber if secure. (if no port number 
is specified, 443 is used by default).  Save this address 
to your favorites or set as your homepage to easily 
access viewLinc from your browser.
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3 In the login screen, enter your username and password. 
Click Login. 

Note: The default administrator username and pass-
word are both “admin”.

4 The main viewLinc screen appears, showing “Getting 
Started” screen. To start using viewLinc, click the Options 
button and choose Locations. 

5 Here you will find a tree view with your location and 
device data. Expand the tree with the plus icon. If you 
don’t see any Location data, click a Location from the 

tree view, and select Options |  Refresh. The selected 
Location’s data should appear.
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If no Locations display, you may not have any locations 
assigned to you, the administrator may need to configure 
the system, or there could be a problem with viewLinc 
itself. If you use Vaisala Veriteq devices, try discovering 
devices - see “Discovering Devices” on page 40. 

Note: The administrator may have set up the system to 
prompt for password periodically to ensure sys-
tem security. When prompted, re-enter your 
password.To change or set the session expiry, 
see“Setting Session Expiry Time” on page 57

For more on locations, see Chapter 4: Locations.

First Steps in viewLinc
When you first log in to viewLinc, load the Locations function 
by clicking the Options button and selecting Locations.  

If you don’t see anything listed in the tree on the left side of 
this window, you will need to start by adding and configuring 
new zones. This is done by clicking Options | System 
Configuration | Locations Manager. From the left panel, right 

click on the System folder and click  Add Zone. The 
‘manage locations’ right must be added by the administrator 
to perform this function. 

Zones can also be created by dragging a device/devices 
across to the System folder in the tree and accepting the 
option to create zones based on the device names. The 
devices must not currently be attached to any other location 
for this functionality to work.  

Once a zone is created, you can then add a location to it by 

right clicking and selecting  Add Location. If no devices are 
displayed in the device browser, your device may not be 
connected properly. If you use Vaisala Veriteq devices, try 
discovering devices - see “Discovering Devices” on page 40. 

What’s New in viewLinc 4.0

Locations: A Location is a ‘data point’ which can be linked to 
any channel and is located in a hierarchical tree of zones. 
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The Locations feature replaces the previous channels/my 
channels functionality, providing improved customization and 
flexibility with more information available from the tree view.

Views: A View is a customized combination of locations 
selected from all available zones by the user. They offer the 
flexibility of navigating a tree view similar to the locations 
view with a customized hierarchical zone organization. They 
can be customized so a user can create a view of all location 
readings regardless of zone. These Views remain saved and 
allow each user to have the software set up in a way that 
better suits their role or job function. 

Trends: Trends are custom graphs which can be built with  
user friendly drag and drop functionality. The trend view  
allows you to combine, contrast and compare location history 
in visual graphs using real-time data.

Dashboards: Dashboards provide the ability to upload a 
custom image for any zone or view and place locations on 
this image (for example a map or floor plan). They provide a 
customized display of the current readings at several 
locations at a glance.

Mobile Support: viewLinc 4.0 provides access from mobile 
devices, allowing you to perform key tasks from your 
smartphone or tablet. Apple iPhone iOS® 3+, Android® 

2.1+, and BlackBerry® 6+ devices are supported. 

Users and Groups: viewLinc 4.0 provides several new 
security options and introduces the concepts of groups, 
users and zones for better access control. Groups allow the 
administrator to better control permissions on a group level 
while maintaining user-based permissions. These features 
provide quicker methods of configuring permissions for 
multiple users and subsequently adding individual user 
permissions as needed. viewLinc 4.0 also provides the ability 
to add an access control list (ACL) to a particular zone and 
give a group permissions specific to that zone. 

Getting Help
If you need help, technical support is available:
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North America

Contact Vaisala Canada Inc, 8am-4pm PST Monday - Friday, 
at 1-866-861-3388 (or 604-273-6850) or email 
veriteqsupport@vaisala.com. See also www.vaisala.com/
lifescience-hitech.

For sales, pricing, quotations, or general information, please 
call 1-800-683-8374 (or 604-273-6850).

Outside of North America:

helpdesk@vaisala.com

Vaisala Headquarters (Finland)

Vanha Nurmijärventie 21

01670 Vantaa

FINLAND

Industrial Instruments

Phone: +358 9 8949 2658

Fax: +358 9 8949 2295

Japan Service Center

42 Kagurazaka 6-Chome

Shinjuku-ku

Tokyo 162-0825 

JAPAN 

Phone: +81 3 3266 9611

Fax: +81 3 3266 9610

China Service Center

Floor 2, EAS Building

No. 21, Xiao Yun Road, Dongsanhuan Beilu

Chaoyang District

Beijing 100027

CHINA

Phone: +86 10 5827 4100

Fax: +86 10 8526 1155

www.vaisala.com/lifescience-hitech
www.vaisala.com/lifescience-hitech
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Chapter 2: Management

This section describes how to:

• Configure various components of viewLinc using the 
Managers from the system configuration menu

• Create and work with views in Views Manager 

• Use access control to give views access to different users 
and groups

• Set up and add locations to a custom dashboard using the 
Dashboard Manager 

• Navigate the Device Manager, add a device and add 
access controls
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About Views Manager
A View is a customized combination of locations selected 
from all available zones by the user. It offers the flexibility of 
navigating a tree view similar to the locations view with a 
customized hierarchical zone organization. Views Manager 
allows you to create and edit views for use throughout the 
application.

Views are useful when you wish to group important locations 
together. For example, a user could create a view of all 
humidity readings or all temperature readings regardless of 
zone. These Views remain saved and allow each user to 
have the software set up in a way that suits their role or job 
function. Once a View is saved it is possible for the 
administrator to assign permissions to that view to a User or 
Group with ‘View’ or ‘Full Control’ permissions.

Creating a New View in Views Manager
1 Select Options | System Configuration | Views Manager.

2 Navigate to a View in the Views Tree. When a view is 
selected, its access control information will appear on the 
right. To create a new view, click Options | New. The 
Options Menu icon turns red to indicate that there are 
unsaved changes.

3 Once the view has been created and named, you can 
add a zone or location to it by navigating the Locations 
tree in the center panel and dragging and dropping it to 
the Views Tree. When you drag and drop a zone, all 

locations beneath it are also added to the view. It is also 
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possible to to add a zone by right clicking the zone and 
selecting  Add Zone.

4 To specify access control for your view, click the view to 
select it then select Options |  Add from the access 
control panel on the right.

5 The access control window appears. Select an access 
control type, user name, and type of permission you wish 
to give.

6 Click  Save. The new permission appears in the Access 
Control List (ACL) When selected, access to the view is 
provided with ‘Full Permission’ by default. 

7 To share the view, click to select the view. It appears in 
the Views Access Control panel. To assign ACLs to the 
view, right click the permission in this panel and select 
Edit. Select the type, name and permission and click  
Save to assign the permission to the view.
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About Dashboard Manager
Dashboards provide the ability to upload a custom image for 
any zone or view and place locations on this image. They 
give the user a visual display of the current readings at 
various locations. 

For example, a floor plan or map of a building can be 
uploaded as the dashboard image, and the locations can be 
dragged and dropped to their corresponding real life 
locations on the map. These locations will display the most 
current readings and can be easily selected to display the 
Popup Trend View. See “Opening Large Popup Trend Views” 
on page 71.

Creating a New Dashboard in Dashboard Manager
1 Click Options | System Configuration | Dashboard 

Manager.

2 Navigate to a Location from the Locations tree and click 
to select it.

3 On the right panel, Click Options | Upload Image.

4 Use the Browse... button to navigate to the image you 
wish to use.  

5 Double click to select the image. It will become the new 
desktop image for your dashboard. The Options Menu 
button turns red to indicate that the current dashboard is 
being edited and the current tree folder is highlighted to 
indicate that the dashboard is in edit mode.  
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6 If it is necessary to resize the image, select Options | 
Resize Image. A grey border will appear around the 
image allowing you to adjust the size in a window.

7 Navigate the locations tree to find a location or zone you 
would like to add to your dashboard. Drag and drop from 
the locations tree to the dashboard on the right. 

Note: It is only possible to place locations on the dash-
board that 1) are a part of the zone being edited 
and 2) are not in the current dashboard yet.

The location or zone will now appear in the image on the 
right. A Zone will display a folder icon that can be double 
clicked to open. A location with data associated to it will 
automatically display and refresh this data on your 
dashboard. To reposition items on the dashboard simply drag 
and drop them around the dashboard.  

Double click the location to display the popup trend view. 
Alternatively, you can right click on the location and select 
Popup Trend. To view the location properties, right click and 
select Properties.

Deleting a Dashboard Item
1 To delete an item from the dashboard, start by clicking on 

the desired item to select it.

2 From the Options menu choose Delete Selected Item.

3 Alternatively, you can right click the desired item to 
delete and select Delete.
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Erasing the Dashboard
Note: The erase operation cannot be undone.

1 To erase the current dashboard, select Options | Erase 
Dashboard. 

2 A confirmation message box appears. Click Yes. The 
current dashboard image and all items on the dashboard 
are erased. 

About Device Manager
The Device Manager is used to add, configure and provide/
manage user access to Devices, Hosts, and Locations. It 
also provides the device discovery functionality which allows 
for the automatic detection and configuration of supported 
Vaisala Devices. The Device Manager consists of 3 panels: 

• Device Browser displays the tree of hosts, devices, and 
channels

• Access Control grants specific permissions for the device 
selected from the device browser

• Device Details displays detailed device information

For information on discovering and adding devices from the 
device manager, See “Discovering Devices” on page 40.

For information on setting up a new Access Control 
permission for a device you have added, See “Creating a 
New View in Views Manager” on page 22 of this chapter and 
follow steps 4 through 6.
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About Locations Manager
The Locations Manager is new to viewLinc 4.0 and is the 
central location for organizing locations into relevant zones 
for use throughout the application. The Locations Manager  
contains 3 panels: Locations, Device Browser, and Location 
Properties.  

The Locations panel allows you to customize the application 
by organizing data into zones, sub-zones and locations. 

• A Location is a single data point connected to a channel, 
which is placed into a zones or sub-zone. The Locations 
you create will appear throughout the application. This 
panel also allows you to work with individual channels by 
linking and unlinking them to different locations and 
deactivating Locations as needed.  

• The Device Browser allows you to view and work with the 
devices currently attached to the system and the channels 
associated with these devices. It also allows you to swap 
devices when required.

• The Locations Properties panel contains 4 tabs: 

• The Properties tab provides extended information 
regarding the selected zone or location. It allows you to 
sort and group locations by their various attributes 
which is useful for larger zones. 

• The Devices tab lists the device channels connected to 
the selected zones/locations. It can also list the device 
channel history of each location. 

• The Access Control tab allows you to view and add 
permissions to a specific zone or location. This 
functionality compliments the user and groups 
permissions allowing for greater customization and 
flexibility. 

• The thresholds tab allows you to view and add 
thresholds (less than or greater than values for 
associated measurements) to the selected locations.   

Where are My Locations?

If you don’t see any Locations listed in the tree views when 
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clicking on the lower left Options button and selecting 
Locations, you will need to start by adding and configuring 
new Zones. This is done by clicking Options | System 

Configuration | Locations | Locations Manager. From the left 
panel, right click on the System folder and click Add Zone. 

Zones can also be created by:
• manually adding a zone using the menu command

• dragging a device/devices across to the tree and 
accepting the option to create zones based on the 
device names  

Give it a name which describes the zone. Once a zone is 
created, you can then add a location to it by right clicking and 
selecting Add Location. If no devices are displayed in the 
device browser, your device may not be connected properly.

• If you use Vaisala Veriteq devices, try discovering devices 
- see “Discovering Devices” on page 40.

Organizing Locations into Zones
To organize your viewLinc screen and keep a closer eye on 
the locations that matter to you, you can organize your 
locations into relevant zones using the Locations Manager.

By default, there is one zone created: System. If you wish to 
see recently deactivated locations, click the left Options 
dropdown and select the Show Deactivated checkbox.



Organizing Locations into Zones

viewLinc 4.0 Administrator Guide 29

Creating Zones
To create a new zone:

1 Select Options | System Configuration | Locations 
Manager. Navigate the locations tree on the left or simply 

right click on the System folder and select  Add Zone. 

2 A ‘New Zone’ folder will appear. Enter a name for the 
zone and press [Enter].

To Add a location to a zone:

1 To add a location to a new or existing zone, browse the 
locations tree to find the location you’re looking for and 
drag/drop the location into the folder you wish to move it 
to.

2 If there are no zones or locations (other than the default 
‘System’ zone), you will need to add a new Location. 
Navigate the Device Browser tree to find a device or 
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channel and drag and drop to a zone in the Locations 
tree.

3 If you have dragged a device with multiple channels to a 
zone, a prompt will appear asking if you wish to 
automatically create sub-zones based on device names 
or simply paste all of the contained channels. Select the 
option you prefer.

4 It is also possible to cut and paste locations from one 
zone to another. To do this, right click on the Location 

you’d like to move and select Cut Location, then right 
click on the zone you’d like to move to and select 

Paste. This performs the same function as dragging 
and dropping as detailed in step 1.

Renaming Zones 
To rename a zone: 

1 From the Locations tree in Locations Manager, highlight 
the zone you want to rename. 
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2 Right click the zone and select  Rename. 

3 In the Zone name dialog box, make your changes. 

4 Press Enter or click outside the dialog box to complete 
the name change.
Note: Renaming zones edits the zone name only; it 

does not change the locations assigned within it. 
To link or unlink Locations to a zone, see “Creat-
ing Zones” on page 29.

Searching for Zones and Locations
Searching the database is done using the toolbar search field 
which appears beside the options dropdown at the top of a 
panel. The search is executed by entering a string with 
wildcards, which in turn filters the visible tree with the 

information entered when the magnifying glass icon  is 
clicked.

The search syntax accepts zones and data locations using 
the following format: ‘Room*/Temp*’ will rebuild the tree 
displaying all Zones that start with ‘Room’ and all Locations 
that start with ‘Temp’. 

Click the magnifying glass icon to activate the filter. An ‘x’ 
icon will appear next to this icon, which indicates the filter is 
active. Click the ‘x’ icon to deactivate the filter. While the filter 
is active, only the zones and locations that match the search 
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criteria will display. Hosts cannot be filtered with the search 
box in Device Manager.

Ordering Columns
To re-sort the display order in a Locations tab:

1 From any of the tabs in the Locations area, right click on 
any column heading.

2 From the dropdown menu that appears, click to select 
Sort Ascending or Sort Descending, or, click on any 
column header to sort all the rows using that column. 
Click again on the column header to sort the list in the 
opposite order.

Linking and Unlinking Channels
In order for a channel to be used as a data source for a 
location, it needs to be linked to a zone. If you want to link a 
channel to a location, or if you no longer want a channel 
associated with a particular location, you can unlink it using 
the Locations Manager. It is also possible to view the history 
of all channels linked to a specific Location by clicking the 
Options dropdown in the Devices tab of Location properties 
and selecting “Include Link History.”

To link a channel:

Note: Before you can link channels to a zone and cre-
ate a new Location, the channel must be set up 
by your viewLinc administrator. Refer to the spe-
cific User Guide to learn more about enabling 
and disabling device channels on your Vaisala 
Veriteq device or 300 Series Transmitter. 

Note: Channels cannot be dropped on a location that is 
already linked to another channel.  It is only pos-
sible to have 1 channel per location.

1 From Options | System Configuration | Locations Manager, 
ensure you have created the zone for the location that 
you want linked to a channel. You must have at least one 
zone created (in addition to System which is created by 
default) in order to link locations.

2 Navigate the Device Browser in Locations Manager and 
expand the device with the channel you’d like to link. If 
you do not see any devices listed, check the Options 
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filter to ensure all devices and channels are visible. If you 
still don’t see any devices, contact your system 
administrator.

3 Drag the channel (represented by the Channel icon) 
from the Device Browser and drop it into a Location that 
is not already linked to a channel in the Locations tree.

4 The channel is now linked with the Location you dragged 
it to.

To unlink a channel:

1 Navigate the Locations tree in Locations Manager to find 
the location with the channel you would like to unlink.

2 Right click and select Unlink Channel. 

3 A prompt will appear confirming that you want to modify 
the location. Click Yes. The channel is now available to 
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link with another location. See “Linking and Unlinking 
Channels” on page 32.

You can also unlink all channels within a zone. This is useful 
when you wish to delete a zone, because all child locations 
must be unlinked in order to delete the zone. Once unlinked, 
the freed channels become available in the Device Browser 
tree. 

To unlink all child locations in a zone: 

1 Navigate the Locations tree in Locations Manager to find 
the zone with the locations you would like to unlink.

2 Right click on the zone and select Unlink child 
channels.

3 A prompt will appear. Click Yes to confirm the 
modification.

Deleting Zones
To delete a zone, you must first deactivate all child locations. 
When you delete a zone, the channels revert to the default 
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zone and can be re-assigned to a different zone from the 
device browser. To move channels between zones, see 
“Creating Zones” on page 29.

To deactivate child locations:

1 From the Locations tree in Locations Manager, expand 
the zone you want to delete.

2 Right click and select Deactivate child locations.

3 A prompt will appear confirming that you want to modify 
the location. Click Yes.

4 The zone will remain in the list until the Locations tree is 
saved. Click the left Options dropdown and select 

Save. 

5 You can now proceed to delete the zone if necessary. 
Note: When a location is deactivated, it still remains 

part of the zone, but is not active. If you wish to 
remove it from the zone entirely, the channel 

must be unlinked using the  Unlink channel 
command. The ‘permanently delete location’ 
option in the right click menu then becomes 
available.

To delete a zone:

1 From the Locations tree in Locations Manager, select the 
zone you want to delete. 
Note: You cannot delete the System zone.

2 Right click and select Permanently Delete Zone. 

3 The zone will remain in the list until the locations tree is 
saved. Click the left Options dropdown and select 

Save. 

Editing Location Properties
To edit location properties:

1 From the Locations tree in Locations Manager, select the 
location you’d like to edit.

2 Right-click and select Edit.
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3 The edit location screen appears.  Enter the name, 
description, units and decimal places as you’d like them 
to appear in viewLinc.

Note: The name, description, units and decimal places 
control the way your location appears throughout 
viewLinc.  If you enter a smaller number of deci-
mal places than your device reads, viewLinc will 
automatically round the data it receives from the 
device to the nearest decimal point.

Hiding and Showing Location Columns
To hide columns in Locations:

1 From the Table View tab in Locations, let your mouse 
hover over any column heading, then click the black 
down arrow that appears. 

2 Select Columns, then select the columns you want to 
display or deselect columns you want to hide. For 
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example, to show a column with colored icons 
representing alarm status, select Icon.

3 Click outside the list, or press [Esc] to hide the options 
list.

Creating and Editing Location Thresholds
Thresholds (less than or greater than values for associated 
measurements) can be assigned to selected locations from 
the thresholds tab in locations manager. It’s also possible to 
deactivate/reactivate and edit an existing threshold from this 
tab.

To create a threshold:

1 From the Locations tree in Locations Manager, select the 
location you want to create a threshold for, then click the 
Thresholds tab in the Location Properties panel. 

2 Click the Options dropdown and select Create X 
threshold (where X is the unit of measure).
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3 The edit threshold window appears, populated with 
default values. Set the desired thresholds. 

4 Click Save.
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Chapter 3:  System Settings

There are several important settings screens in viewLinc, all 
located under the System Configuration tab. This section 
covers administrative tasks such as:

• Discovering devices

• Adding devices and hosts

• Auto-swapping devices

• Removing devices

• Editing device and location properties

• Configuring email settings

• Editing alarm email templates

• Creating, editing, or deactivating user accounts and 
passwords

• Granting user permissions for alarm editing capabilities

• Granting user permissions to see certain locations

• Choosing device and location description display length 
(aliases)

• Choosing temperature measurement unit preferences

• Setting session expiry time

• Creating preconfigured comments

For information on the event log and generating reports, see  
Chapter 7: Events, and Chapter 8: Reports. For 
information on setting threshold alarms, see Chapter 5: 
Alarms. For more information on administration and 
management, see Chapter 2: Management.

Let’s begin working with Devices and Locations within 
System Configuration.
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Discovering Devices
To discover recently attached Vaisala Veriteq devices which may not 
show up in the Device Browser automatically:

Note: 300 Series Transmitters are not recognized by 
viewLinc using the Discover devices procedure;  
use your Digi Discovery software if required.

 Select Options | System Configuration | Device Manager.  
Select the host machine you wish to scan, then right click 

and select Discover Devices, or select Options | Host |  

Discover Devices from the device browser in the left 
hand panel: 

Note: This process may take several minutes, depend-
ing on the number of Vaisala Veriteq devices 
and/or components in your network.

Adding Devices
You may want to add a device to your system if:

• discovering devices is taking too long

• you are adding a 300 Series Transmitter device

• you want to add a variety of device types at one time
Note: To add multiple Vaisala Veriteq devices at one 

time, see  “Discovering Devices” on page 40.
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To add a Vaisala Veriteq device:

1 From the Device Browser in Device Manager, select a 

host, then select Options | Host | Add Device.

2 In the Add Device screen, select Veriteq Logger from the 
Device Class dropdown list.

3 Enter the COM port number.

4 To add a combination of Vaisala Veriteq devices and 300 
Series Transmitter devices, select Upload Definitions File 
then enter or browse to the correct file. To add several 
Vaisala Veriteq Devices, see “Discovering Devices” on 
page 40. To create a Definitions File, see the FAQ on 
page 139.

To add a 300 Series Transmitter device:

Note: Ensure no other users are logged on to the 
transmitter you want to add.

1 From the Device Browser in Device Manager,  select 
Options | Host | Add Device as above.

2 In the Add Device screen, select 300 Series Transmitter 
from the Device Class dropdown list.
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3 Enter the following:

a Disconnect After Scan: To maintain a persistent con-
nection to the device, choose False.

b Connection Type: If the transmitter has a LAN or 
WLAN module, select Network. If you use an external 
Digi device, choose COM Port.

c IP Address: See your administrator or check the De-
vice box.

d Sample Rate: Choose 90 (recommended, but you can 
modify the rate if you need more or less recorded da-
ta).

e Connection Timeout: To ensure continuous monitor-
ing, do not change. Contact your network administra-
tor if required.

4 To add several 300 Series Transmitters or a combination 
of Vaisala Veriteq devices and 300 Series Transmitter 
devices, select Upload Definitions File then enter or 
browse to the correct file. To create a Definitions File,  
see the FAQ on page 139.

Swapping Devices
If you need to send a device for maintenance (such as 
recalibration), you will need to swap it for another device to 
ensure continuous monitoring and alarming. 

Note: If a device is removed without being swapped, 
this will trigger a communication alarm. 

When a device is swapped, the change is noted on the 
Location History report (the report shows the device serial 
number for a reporting period). If, during the reporting period, 
the device was swapped, this event is listed in the report 
summary.  

To swap a device:

1 Ensure the new device has the same settings as the 
device to be swapped (see Options | System 
Configuration | Locations Manager, or refer to your 
Vaisala product User Guide).
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Note: Each Vaisala Veriteq device must be reviewed 
separately using vLog, and the COM port to 
which they are connected must be selected.

• COM port/IP address. Device is on the same COM port 
(attached to the same cable). If you are swapping a 300 
Series Transmitter connected as a network device, 
ensure the new transmitter has the same IP address.

• Name. Device is not retired or deactivated. 

• Status. Device is not in active alarm mode.

• Sample Interval. Devices have the same sample 
interval.

• Channels. Devices have the same channels enabled 
and be using the same units of measure for each 
matching channel.

• Audit Trail. Vaisala Veriteq devices are not linked to a 
vLog Audit Trail.

2 From Options | Locations, navigate the system tree to 
find the device you want to swap. Right click and select 

 Pause Device Alarming. 

3 In the Pause Device Alarming screen, you can add a 
comment about why you are swapping devices, and 
specify the expected duration for the pause. This will 
ensure no communication or threshold alarms are 
triggered when disconnecting the device.

4 Click OK.

5 Disconnect the device you want to swap, and connect 
the new device. If you are swapping a 300 Series 
Transmitter, unplug the power source and plug it in 
again.
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6 Click Options | Refresh to update the device list (you may 
have to wait a few minutes for the device to appear). If 
the new device has been previously swapped it will be 
found in the list of deactivated devices (to view, click 
Show Deactivated Items from the Options dropdown).

7 From the Device Browser panel in Options | Locations 
Manager, select the device you have removed.

8 Right click and select  Swap this device with...

9 Verify the correct device is identified in the With field, 
then click OK. viewLinc will reassign the device.

10 If you want the new device to resume alarming, navigate 
the system tree from Options | Locations to find the 

device you want to resume. Right click and select  
Resume Device Alarming.

Removing Devices
Because viewLinc’s communication alarms are set up to 
notice if any device is not communicating with the system, 
you need to use the Deactivate device feature to remove a 
device from the system. 

To deactivate a device:

1 Select Options | System Configuration | Locations 
Manager.

2 From the Device Browser panel, select the Host and then 
the device you want to deactivate.



Editing Device Properties and Aliases

viewLinc 4.0 Administrator Guide 45

3 From the Options | Device menu, click  Deactivate 
Device.

4 A message appears, asking that you confirm you want to 
remove this device. Click Yes.

 You can now remove the device from the network.

Editing Device Properties and Aliases
viewLinc allows you to edit a Vaisala Veriteq device 
description (maximum 16 alpha-numeric characters stored 
within the device), as well as its alias (maximum 64 alpha-
numeric characters, not stored within the device). You can 
edit a 300 Series Transmitter alias in viewLinc. 

Editing device properties allows you to specify a description 
or alias that viewLinc will use for that device. You can set 
which identification (device description and/or alias) viewLinc 
uses in Options | System Configuration | Preferences | Channel 
Description (see “About Preferences” on page 55).

To modify additional device properties, refer to your Vaisala 
product User Guide. 

Note: If your device is linked to the vLog audit trail, you 
first need to either disable the link to the audit 
trail or edit the device properties in vLog.

To edit device properties: 

1 From Options | System Configuration | Device Manager, 
select the Host and then the device whose properties 
you want to edit.
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2 On the Device menu (or the right-click context menu) 

select  Edit Device.  

3 In the Edit Device Properties screen, in the Description 
text box, enter the new information (maximum 16 
characters for Vaisala Veriteq devices only). In the Alias 
text box, enter a more descriptive Alias (maximum 64 
characters), if you want. This Alias is used if you specify 
in Options | System Configuration | Preferences | Channel 
Description that viewLinc displays aliases instead of the 
descriptions stored in the devices.

4 Click OK to save.

Editing Channel Properties and Aliases
viewLinc allows you to edit a channel’s description, alias, and 
preferred temperature units, if applicable. This is useful when 
you want to easily identify a specific channel onscreen.

Note: Depending on the device you use, not all device 
channels can have their descriptions modified.
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To edit channel properties: 

1 From Options | System Configuration | Device Manager, 
select the Host and then the device whose channel’s 
properties you want to edit.

2 Select the channel you want to edit.

3 On the Options | Channel menu select  Edit Channel or 
right-click and select Edit Channel. 

4 In the Edit Channel Properties dialog box, in the Alias 
text box, enter a more descriptive Alias (maximum 64 
characters), if you want. This Alias will be used if you 
specify in Options | System Configuration | Preferences | 
Channel Description that viewLinc displays aliases 
instead of the descriptions stored in the devices.

5 In the Description text box, enter a description (maximum 
12 alpha-numeric characters).

6 Click OK to save.

If you do not want to use the system default temperature 
units (set on the Options | System Configuration | Preferences 
tab), you can modify the temperature units used for a specific 
location. To clear existing unit preferences and accept the 
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system default, you will need to edit the location from the 
Locations manager and select the option Use System Default.

Adding Hosts
viewLinc 4.0 provides the option of adding multiple host 
machines so devices residing on these host machines can 
be added and monitored as locations.

To add a host machine:

1 From the Device Browser in Device Manager, select 

Options | Add host.

2 The Add Host window appears. Enter the hostname or IP 
address of the host you’d like to add.

3 Click OK.  The viewLinc system will discover the host and 
all devices residing on it. Device discovery on the new 
host may take a few seconds to several minutes to 
complete. You can continue with other activities during 
the discovery process. You will be notified when the 
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process is complete.  Click Yes when prompted to 
refresh.

Configuring Email Settings 
Alarm notifications are sent via email, therefore 
administrators must set Email Settings to properly send email 
messages from your mail server. If you aren’t sure which 
usernames and passwords to use or which check boxes to 
enable, contact your IT Administrator.

To configure Email Settings:

1 In viewLinc, choose Options | System Configuration | 
Templates | Email Templates. The Email Settings screen 
appears, showing the email templates in use for various 
viewLinc messages

2 Choose Options | System Configuration | Email Settings.  
The Email Settings screen appears:

3 Enter the Administrator’s Email address. This address is 
used to receive all system notifications.

4 Enter a valid “From” address. Email notifications from 
viewLinc will be “from” this address, so the email address 
must exist. Contact your IT administrator to create a 
“From” address if needed. For example: 
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viewlinc_system@yourcompany.com or 
controlroom47@yourcompany.com 

5 In the Outgoing Server area, enter:

• an outgoing SMTP mail server name (e.g., 
mail.yourserver.com)

• an outgoing mail server port (a number between 1-
65535. Your IT Administrator will have this information)

• an appropriate server timeout interval

6 If your outgoing mail server requires authentication, 
select the SMTP Authentication check box and enter the 
username and password to send mail on that server. 
Note: viewLinc automatically uses secure SMTP if it is 

supported by the SMTP server.

7 If your outgoing mail server requires confirmation 
through a POP3 connection before sending mail, 
configure the following settings:

a Select POP3 connection is required. 

b Enter the incoming POP3 mail server name.

c Enter the incoming mail server port.

d Select POP3 Authentication, then enter a username 
and password for a valid POP3 account for the view-
Linc system to use. 

8 Click Test Email to test your settings. If they are OK, 
continue. If not, adjust the administrator e-mail address 
and verify the settings as indicated in these steps until 
the test email is sent successfully.  The ‘administrator 
email address’ field should not be left blank. 

9 Click Save to save the e-mail settings, which will be used 
for email notifications throughout viewLinc.

Editing Alarm Email Templates
You can edit the information that is sent about alarms in the 
various alarm notification emails: for example, the email 
notifying you about a Communication or Threshold Alarm, a 
repeated Alarm, an Acknowledged Alarm, or a Device 
Transfer. You may want to edit emails to modify contents if 
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sending emails to a pager or cellular phone, or for a specific 
purpose within your company. 

You can edit email templates to include or not include many 
different items, for example:

• Device description

• Event Type

• Details of Alarm

• Date

• Time

• Channel

• Comments (custom or preconfigured comments) 

To edit email templates:

1 From Options | System Configuration | Templates | Email 
Templates, select the row containing the email template 
you want to edit and click  Edit Email Template. Or, 
double-click the row to edit. The Email Template screen 
appears. 

2 In the Email Template screen, edit the email template 
message. Items in [brackets] are macro variables that 
viewLinc will insert in the email. To choose different 
variables, click the location where you want to add a 
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macro, then click Macros and select the variable you want 
to use from the drop-down list.

3 When you are finished, click Save.

Working with Users
viewLinc 4.0 provides several security options including the 
concept of users.  Each user has a set of permissions which 
are enabled when the user logs in, governing what tasks they 
can perform and what parts of viewLinc they can access.

When you install viewLinc, a default “admin” account (user 
account with Full Control) is created. The username and 
password are both “admin”. 

It is important to change the admin password as soon as 
possible (see “Editing Users and Passwords” on page 54). 

You also need to create accounts for other users, specifying 
their login name, their email address and schedule (times 
they should receive alarm notification), their security level, 
the channels they can see, and their authentication method 
(if they will use a viewLinc login or use the same login as their 
Windows login).
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About Contact Schedules
viewLinc allows you to set times when a particular user 
receives alarm notifications. Users can be set to receive 
notifications “always”, “never”, or on a schedule of times and 
rotating dates (for example 07:00-19:00 on a 4 day on, 5 day 
off rotation, or 08:30-17:30 on a 5 day on, 2 day off rotation). 

Contact schedules are applied to user accounts, so schedule 
patterns (days, hours) must be set before any can be applied 
to a particular user.

To create contact schedules:

1 From Options | System Configuration | Contact Schedules, 

click Add Contact Schedule. The Contact Schedules 
area becomes active. 

2 From the State drop-down, choose Enabled. This allows 
you to set start date, repeat days pattern, and the time 
periods. 

3 Choose a start date by typing in the text box or choosing 
from the calendar. 

4 Specify Repeat Days. To repeat the contact schedule 
every 7 days, enter 7. For 9 days, enter 9. The maximum 
value is 99 days.

5 In the Time Period rows, enter the time period in 24-hour 
time in the following format: xx:xx-yy:yy where xx:xx is 
the start time and yy:yy is the end time. For intermittent 
schedules, separate time periods by a comma. For 
example, 08:00-12:00, 13:00-16:00). For contact all day, 
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enter 00:00-00:00. For no contact in a day, leave the day 
blank.

6 Click Save. Your schedule will be named “New 
Schedule”. To rename it, double-click the row or select 
Options | Rename. 
Note: To temporarily disable the scheduling capability 

(for example, to have notifications sent “always” 
or “never”, choose “Always” or “Never” from the 
State drop down box). You can then choose or 
edit the schedules you’ve set at later time and 
re-select “Enabled” when necessary.

Editing Users and Passwords
To edit user accounts and passwords:

1 In viewLinc, go to Options | System Configuration | Users.

2 Select the user to edit and choose  Edit User from the 
Options dropdown menu.  Or, double-click the row 
containing the user you want to edit. The User Properties 
screen appears. 

3 From the User Properties screen, edit settings as 
needed.

4 Select Save from the Options dropdown menu.
Note: You can only edit passwords in viewLinc if you 

are not using Windows authentication.

To create a new user account:

Creating a new user is covered in Permissions.  See 
“Creating a New User” on page 102.

Deactivating Users
To deactivate a user:

1 From Options | System Configuration | Users, select the 
User you want to deactivate.

2 Click Deactivate User from the Options dropdown 
menu. 

3 Click Yes to confirm the change.
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Reactivating Users
To reactivate a user:

1 From Options | System Configuration | Users, click 

Show Deactivated Users. All deactivated users appear 
in grey text.

2 Select the user you want to reactivate and click 
Reactivate User from the Options dropdown menu. 

About Preferences
The preferences section of viewLinc contains several system 
preferences that affect the behaviour and display of the 
application throughout. This section controls the following 
options in viewLinc:

• Choosing whether the Channel and Device descriptions  
displayed in viewLinc come from the system or from a 
user-defined alias.

• “Preferred Temperature Units” can be set as C (Celsius) or 
F (Fahrenheit). This procedure does not alter how the 
logger measures temperature - it only alters the units in 
which temperature is displayed.

• Choosing session expiry time after which a user or 
administrator must reconfirm their identity by reentering 
their password. This prevents non-authorized users from 
making changes to viewLinc. This setting is applied 
universally to all viewLinc users and administrators.

• Choosing if comments are required or optional.

• Choosing the default value for MKT Activation Energy.  
This is used in reports and trends.

• Technical support log allows the administrator to turn 
support tracing on/off.  It sets the amount of information to 
be logged in case of any support issues.

• The security key is displayed here. This is the license key 
purchased from Vaisala for this system.
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Choosing Device and Channel Description Lengths 
(Aliases)
Vaisala Veriteq devices have descriptions stored inside them 
that have a maximum length of 16 characters (300 Series 
Transmitters do not store descriptions). Channel descriptions 
have a maximum length of 12 characters. Some 
administrators may prefer to display a longer, more 
informative description. To accommodate this, viewLinc 
allows you to set an alias for a device or channel, up to 
maximum of 64 characters.

To choose whether viewLinc should display the description 
stored in the device or its alias, set the Channel Description 
and/or Device Description preference in Options | System 
Configuration | Preferences.

To set the Channel or Device Description preference:

1 In viewLinc, go to Options | System Configuration | 
Preferences.

2 In the Channel Description row, click to choose “Use 
Channel Description from Device” or “Use Channel Alias” 
from the Value column.

3 Repeat your preference choice for Device Description. 
Events, Alarms, Reports, and Email will all use the 
designated descriptions of Channel and Device.

Choosing Temperature Measurement Unit Prefer-

ences
When viewLinc is installed, temperature is set to display in 
degrees Celsius. You can configure viewLinc to show 
temperatures in either Celsius or Fahrenheit.
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To choose temperature measurement units:

1 In viewLinc, go to Options | System Configuration | 
Preferences. 

2 In the Name column, select Preferred Temperature Units 
and in the Value column, choose either Celsius (C) or 
Fahrenheit (F).

Note: This procedure does not alter how the device 
measures temperature - it alters the units in 
which temperature is displayed (except for chan-
nels which already have preferred unit settings 
assigned).

Setting Session Expiry Time
viewLinc allows you to set a session expiry time after which a 
user or administrator must reconfirm their identity by 
reentering their password. This prevents non-authorized 
users from making changes to viewLinc.

You can choose to set this expiry time as “never”, “always” 
(that is, requiring password confirmation before making any 
change to the system), or intervals of 1, 5, 10, 15, 30 and 60 
minutes after logging in or reconfirming their password. 

This setting is applied identically to all viewLinc users and 
administrators.

To set the session expiry:

1 From viewLinc, choose Options | System Configuration | 
Preferences. 

2 In the Name column, select Users must confirm their 
identity, then choose an expiry time in the Value column.
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Creating Preconfigured Comments for Email Messages
Administrators can preconfigure standard comments to be 
sent as part of email notifications for alarms and transfers, as 
well as have them included in the Event Log. 

To use these comments in email notifications, the 
[Comments] parameter must be present in the specific Email 
Template. For example, if you set a Communication Alarm to 
email someone when it is triggered, the preconfigured 
comment you select for that alarm will be included in the 
email if the [Comments] parameter is included in the email 
template for Communication Alarms.

You can use preconfigured comments in alarm templates, or 
when setting up a custom alarm.

To create preconfigured comments:

1 From Options | System Configuration | Comments click 

Add. 

2 In the box that contains the text, New comment, enter the 
comment and press [Enter]. 
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To use preconfigured comments (in a custom Communication 
Alarm, for example):

1 From Options | System Configuration | Templates | Alarm 
Templates, highlight a template, then click the Comments 
tab. 

2 On the Comments tab, select a comment from the 
Preconfigured Comments drop-down list. Your 
preconfigured comments will appear in the Comments 
box, allowing you to make additional changes to the text, 
if required. 

3 Choose the email template to edit. 

4 In the Alarm Message field, ensure the [Comments] 
variable is present. The preconfigured comment you 
selected in Communication Alarm settings will be 
inserted in the email message when it is sent. 

5 Click Save. 

To delete preconfigured comments:

1 From Options | System Configuration | Comments, 
highlight the comment to delete. 

2 Click Options | Delete. 

To choose if comments are required or optional:

1 From Options | System Configuration | Preferences, click 
the dropdown beside “comments are required on 
changes.”

2 You can choose between 4 options:

• “Comments are not required”

• “Comments are optional”

• “Comments are mandatory”

• “Pre-configured only comments are mandatory”

Let’s move on to looking at Locations in viewLinc.
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Chapter 4: Locations

This section is for administrators and general users.

In this section, you’ll learn about:

• Locations, Trends, and Zones

• Selecting Channels and Zones to display as Locations

• Opening Large Popup Trend Views 

• Viewing and Working with Real-time Graphs in a Large 
Popup Trend View

• Displaying or hiding Location information

Let’s get started learning what locations are in viewLinc.
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About Locations

What is a Location?
The Locations feature is new to viewLinc 4.0, giving the user 
improved customization with more information available 
more readily from the Location tree view. A Location is a 
‘data point’ which can be linked to any single channel and 
can be located in a hierarchical tree of zones. It removes the 
hardware definition of host/device/channel from the Location 
tree, allowing any channel to become a Location.  Depending 
on the type of Vaisala devices you have installed, a device 
may have up to five active channels and up to 27 definable 
channels available to measure readings such as 
temperature, relative humidity, voltage, pressure, current, 
etc. (one channel is used for each type of measurement). 

Note: 300 Series Transmitters Output Quantities are 
displayed as Channels. (currently 27 possible 
types)

Using viewLinc, you can monitor any device that is 
connected to the network using Locations. 

When you first log in to viewLinc, you can load the Locations 
function by clicking on the main screen Options button and 
selecting Locations. This window includes: 

• zones and locations available for monitoring in an 
expandable tree view 

• locations available for each selected zone

• table view which allows you to view and monitor data from  
zones and/or locations

• trend view which allows you to combine, contrast and 
compare location history in visual graphs with real-time 
data

• context-sensitive help
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Understanding the Locations Screen
The Locations screen in viewLinc contains many important 
features: 

 

 2

 

3

5

         4 1

Item Details

1 - Tabs Contains main viewLinc tabs: Table View, Dash-
board, Location Alarms, Trend.

2 - Options 
dropdown

Contain buttons like Refresh, Popup Trend, Pause 
Alarming, etc.  These menus are context-sensi-
tive - they change depending on which tab is 
open and which item is selected within the tab.

3 - Zones area Where configuration of locations and zones takes 
place. Use the locations tree to organize the loca-
tions that are connected to viewLinc into zones.  
Zones are represented by folders with Locations 
located below them in the tree.  Locations are 
found below the zones. The table view on the 
right will display information about the zone or 
location that you have selected.

4 - Search You can search for locations here by entering a 
search term in the text box and clicking the mag-
nifying glass icon.

Table 2: Important features of the Locations screen
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The Locations screen displays general information about the 
corresponding data source. When a location has no data 
source associated with it, it will be displayed with a blue 
exclamation mark icon. The Locations screen can also 
display views by clicking anywhere in the dark grey bar 
labelled “Views.” Views have the same functionality as 
locations, but are customized versions of the locations tree.

Each View can also have a Trend associated with it that is 
displayed in the Trend panel whenever a View is selected. A 
Trend is a historical view of Location data.

Most columns in the 4 tabs (Table View, Dashboard, Location 
Alarms, Trend) are easy to understand; however, here are 
their definitions to help you get familiar with viewLinc. To see 
all options, see “Hiding and Showing Location Columns” on 
page 36:

5 - Location 
Details

In Table View mode, includes details on channel 
configurations, paths, current data readings, lat-
est timestamp and threshold information.

Column Displays

Icon The color coded icon associated with the 
location.

Location ID Device description (can be edited from the 
System tab). 

Device ID The number associated with the device.

Location Path The subfolders currently linked with the 
location.  The top folder in the path will 
always be the default ‘System’.

Location Description The description for the location that was 
entered at the time of creation.

Table 3: Columns of information in Locations

Item Details

Table 2: Important features of the Locations screen
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Understanding the Options Dropdown Menu in 
Locations
The Options dropdown menu in the left panel of Locations 
allows you to select commonly used commands.  Some of 
these commands will be available or greyed out depending 

Device Serial Number The serial number associated with the 
device.

Device Description The description that was entered for the 
device at the time of configuration.

Channel ID The system defined number associated 
with the channel.

Channel Number Number representing the channel for that 
device (each device has 1 or more chan-
nels, and labels them 1, 2, and so on).

Channel Description Description of channel (editable from the 
System tab).

Value Reading of that channel, for example the 
temperature in Celsius.

Timestamp Time that the last reading was taken.

Device Status The current status of the device. Displays 
errors if the device is inactive.

Threshold Status “OK” appears if there are no currently 
active alarms. Changes to indicate if a 
threshold alarm condition has been 
detected.

Threshold Summary Summary of threshold status, if active. 

Column Displays

Table 3: Columns of information in Locations
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on the location/zone you have selected, if any. The following 
options are available:

• Refresh: Reloads the selected tree.

• Expand/Collapse All Zones: Expands/collapses all zones 
and sub-zones of the tree in the left locations panel.

• Pause Threshold Alarming: Pauses the threshold alarms 
for the zone or location selected in the tree.  If a zone is 
selected and there are child locations, this command will 
pause alarming on all child locations within the selected 
zone.

• Resume Threshold Alarming: Resumes threshold alarms in 
all data locations selected in the right panel.  If a zone is 
selected and there are child locations, this command will 
resume alarming on all child locations within the selected 
zone. 

Understanding The Tabs in Locations
The right panel in locations is a tabbed panel consisting of 
four tabs that are updated as the Locations tree is navigated.  
The four tabs are as follows:

• Table View Tab: Displays the location, device, threshold 
and status information for the currently selected location. 
Only locations that have channels assigned to them will be 
displayed. 

• Dashboard Tab: Displays the dashboard for the current 
selected location or zone and sub-zones. These 
dashboards are managed in Options | System 
Configuration | Dashboard Manager. Locations are 
displayed on the dashboard with their current reading. 
Zones are displayed as a folder icon and can be opened 
by double clicking this icon.  Hovering over a zone or 
location will cause the mouse pointer to change and will 
display a tooltip with extra information.

• Location Alarms Tab: All active alarms for the current  
location or zone and sub-zones are shown under this tab. 
If acknowledgement is required on an Alarm, the alarm will 
be present in this window whether it is on or off. If 
acknowledgement is not required on an alarm, the alarm 
will be present in this window only if it is currently on. A 
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user can acknowledge threshold alarms if they have 
‘Acknowledge Alarms’ permission on that location. The 
device alarms can be acknowledged if ‘Acknowledge 
Alarms’ is available on at least one location referencing 
that device. For further information on acknowledging 
alarms seeSee “Viewing Active Alarms” on page 98.

• Trend Tab: When browsing the Locations tree, the trend 
tab enables you to build and display location trends quickly 
and save them as Views as follows.  

Building a Trend with the Trend Tab
To create a custom trend using the trend tab:

1 Navigate the Locations tree to find a location you would 
like to graph in a trend.  

2 Drag and drop one or several locations from the 
Locations tree onto the graph panel on the right. 

3 Save the trend as a View by clicking the Options 
dropdown and selecting Save as View. The view will then 
become available in the views section and can be 
accessed any time. You can continue to build upon and 
modify your trend at any time by simply dragging more 
channels onto the graph and saving again.

4 Check and uncheck the ‘Selected’ column in the grid 
located in the Locations tab just below the graph. Click 
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the  live button or click Options | Refresh to refresh the 
graph and it will graph only the data you have selected 
with these checkboxes.  

5 Plot threshold lines on a location by checking the 
‘Threshold Lines’ column and refreshing again. The 
panel displays statistics information for each graph line.  

6 Click on the Group Statistics tab to see the totals and 
max/min ranges for all locations together.  

7 Click on the Scale tab to adjust the values for the scale of 
the graph. The default low/high range is set to auto.  
Clicking on this ‘auto’ text enables you to enter new 
values for the graph which will be applied when the graph 

is refreshed or the  Live button is selected. There is a 
maximum of 16 locations (lines) per trend.

8 Click Options | Save As Report and specify a name for 
your report. The report will be available with the name 
you specified in the Reports section.

9 The trend tab also contains navigation controls which 
allow you to navigate historical data trends and refresh 
the view as necessary:  

• Pressing on the  forward and  back arrows will 
adjust the start time accordingly, while pressing on the 
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double forward and back arrows will adjust the start 
time by a greater distance.  

• Pressing the  live button will fetch the most recent 
data using the ‘duration’ combo box value to adjust the 
start date of the graph.

• The top right check box labelled ‘Auto Refresh On’ will 
toggle the auto refresh option. Uncheck it to stop 
periodic updates, or check it to have the same effect as 

pressing the  live button.  

• Navigating or zooming within the trend will 
automatically uncheck the “Auto Refresh On” option, 
because when you navigate within you are then 
viewing historical data. See “Real-Time Graphs” on 
page 73.

Understanding the Dropdown Menus and Buttons in 
the Locations Tabs
The four tabs in the Locations panel contain various options 
and control buttons to help you customize, manage and 
display data.
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Table View Tab Options

• Refresh: Reloads grid data with latest information.

• Popup Trend: Pops up the trend graph display of the 
selected row.

• Properties: Displays the properties window for the selected 
row.

• Pause Threshold Alarming: Pauses threshold alarming of 
the selected row.

• Resume Threshold Alarming: Resumes threshold alarming 
of the selected row.

• Pause Host Alarming: Pauses host device alarming for the 
selected host.

• Resume Host Alarming: Resumes host device alarming for 
the selected host.

• Pause Device Alarming: Pauses alarming on the selected 
device.

• Resume Device Alarming: Resumes alarming on the 
selected device.

Dashboard Tab Options

Contains only the Refresh option, which reloads data from the 
server when clicked. 

Location Alarms Tab Options 

• Refresh: Reloads data from server. 

• Print:  Prints the Active Alarms information. The Active 
alarm information will print, including all the details about 
the alarms by clicking this button. 

• Export the Active Alarms information to Excel: All active 
alarm information can be exported to excel with the details 
about the alarms present under the Active Alarms tab. 
Clicking on the Export to Excel button asks the user to 
open or save the TSV file as shown. See “Viewing Active 
Alarms” on page 98.

Note: TSV format is used because it is not affected by 
regional settings, unlike the CSV format.
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Trend Tab Options

• Refresh: Reloads data from server. 

• Clear: Clears all channels from the trend. This option is 
visible when building trends from the ‘System view’ tree. 

• Save as View…: Displays a window to save the current 
trend as a View. This option is visible when building trends 
from the ‘Locations’ tree. It requires ‘Manage Views’ rights. 

• Save as Report…: Displays a window to save the current 
trend as a single page ‘History Report’. This option 
requires ‘Manage Reports’ rights. 

• Save: Saves the current trend. This option is visible when 
browsing trends from the View tree. It requires ‘Manage 
Views’ rights. 

• Popup in New Window: Pops up the trend in a new browser 
window. This option is visible when browsing trends from 
the View tree.  See “Opening Large Popup Trend Views” 
on page 71.

• Include Realtime Samples: When checked, this option will 
draw real time samples along with the logged data. 

• Show Data Markers: When checked, this option will draw 
small markers on the trend, indicating exactly where the 
readings took place.

Opening Large Popup Trend Views
The Large Popup Trend window contains the most current 
data reading for the location, any related threshold settings, a 
graphical representation of recent historical data readings, 
and an area to indicate an active alarm. 

Note: You can view a particular location’s data reading 
in a single window, or you can open multiple 
location windows. If you use Internet Explorer, 
ensure your browser is set up to open new links 
in a new window or tab. Go to Tools | Internet 
Options, then, on the General tab in the Tabs 
section, click Settings and choose to open links 
from other programs in A new tab in the current 
window. 
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To open a large popup trend view:

1 From the Options | Locations window, browse the 
locations tree and left click to select a location you want 
to view. 

2 Right click  Popup Trend or double click the selected 
location line. A new resizeable window containing 
information about the selected location appears. 

3 Repeat steps 1 and 2 to view multiple large popup trend 
views.  Many users choose to have multiple monitors 
displaying multiple trends by dragging each windows to 
various monitors as desired.

To close a large popup trend view, click the close box (x) in 
the top right corner of the window.

To acknowledge an alarm, see “Acknowledging Alarms” on 
page 94.
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Real-Time Graphs
With viewLinc, you can view live data in graphical form at any 
time using the Trend tab in Locations.

To view live data as a graph:

1 From Options | Locations, click the Trend tab.

2 Expand the Locations tree on the left to find a Location   
you wish to graph. Drag locations as you wish from left to 
right (with a limit of 16 channels).  The comparative data 
of all the Locations you selected will be displayed in the 
Trend tab. 

3 Right click on a location and click Popup Trend. This 
opens the large trend view with both a graph and current 
value (for a single location only).

In this screen you can view the most recent historical trends, 
and hover over specific data points for more detailed 
readings.

Reading Graphs in Popup Trend View
When you open a location, you can see both a numerical and 
graphical representation of the device reading. Here is a 
description of the key elements in the graphing area:

Item Description

Title bar Displays the name of the Zone and type of 
location data reading (humidity, tempera-
ture, voltage or current).

Header bar Indicates the date and time of latest read-
ing; the time zone is based on the time 
zone setting of the PC running the 
browser. The graph header bar also dis-
plays the number of data points being 
measured.

Table 4: Large Popup Trend view elements
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Numerical display area Displays most current data value in units 
being measured, as defined by the 
user(see page “Choosing Temperature 
Measurement Unit Preferences” on 
page 56 to change).

Graph area A graphical representation of data history 
is displayed here.

Left-side Y-axis Shows the scale for the data displayed in 
the graph.

X-Axis time scale Shows the reporting time frame ( if you 
use Internet Explorer, you can only view 
the last 300 data points; all other brows-
ers will show the last 1000 points).

Graph Line Indicated by a line to show historical mea-
surement readings based on a specific 
date or time frame. Move your mouse and 
hover over a specific point to show the 
specific X- and Y-axis values.

Threshold Line Indicated by a color-coded line (based on 
threshold setting) to show historical 
threshold values. Move your mouse and 
hover over a specific point to show the 
specific X- and Y-axis values.

Active Alarms area Displays active alarm details: Threshold 
value and amount exceeded; alarm date 
and time; whether the alarm was 
acknowledged, and by whom. Permits 
user to acknowledge an alarm.  If you 
don’t see the active alarm area, there may 
be no alarms to display.  It can still be 
shown using the double arrows on the 
right hand side of the popup trend.

Item Description

Table 4: Large Popup Trend view elements
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Viewing Graph Detail in Large Popup Trend View
With a Large Popup Trend View open, you can also zoom in 
on a specific time period. 

Simply click anywhere on the graph and drag your cursor to 
the right to highlight the time period you want to magnify, then 
release. The magnified area displays until the next live 
update. To return to full view immediately, double-click 
anywhere on the graph (or to zoom out, select an area, drag 
cursor to the left, then release). 

Acknowledging Alarms from Large Popup Trend 
View
From a Large Popup Trend View window, you can 
acknowledge alarms. 

To acknowledge an alarm from a large popup trend view:

1 From the large popup trend view “Active Alarms” panel, 
click Acknowledge.

2 In the Acknowledge Alarm dialog box that appears, enter 
information to describe what was done to correct the 
alarm situation, or a general comment. You can also 
select from the dropdown of preconfigured comments if 
you prefer.

3 Click Acknowledge. 

Status bar Indicates channel monitoring status (OK or 
Alarm/Alarm condition type).

Item Description

Table 4: Large Popup Trend view elements
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Chapter 5: Alarms

Alarms and Alarm Acknowledgement are the keys to success 
with the Vaisala Veriteq Continuous Monitoring system. 

In this chapter, you’ll learn to:

• Understand Types of Alarms in viewLinc

• Create Alarm Templates

• Set threshold and Device Alarms

• Deactivate and Reactivate Alarms 

• Acknowledge Alarms

• Pause Alarms

To learn about how to generate Alarm reports, see Chapter 
8: Reports.

Let’s get started looking at alarms.
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About Alarms
There are several types of alarms in viewLinc: threshold 
alarms, communication alarms, event log validation alarms, 
and device sampling alarms. If you are using validatable 
devices, you may also receive device validation alarms and 
calibration alarms. 

Users with the appropriate ACL permissions can set 
threshold alarm limits and when conditions exceed these 
limits, alarms are triggered which notify key staff of the 
condition. Staff with Acknowledge Alarms permissions or 
higher then acknowledge the alarms in viewLinc. 

All transactions are recorded in the Event Log and the 
Historical database.

Using viewLinc, you can customize the alarm information that 
is issued for threshold, communication and device alarms by 
configuring them from Options | System Configuration | Device 
Manager or by modifying alarm/threshold templates from 
Options | System Configuration | Templates | Alarm Templates.

Threshold Alarms

Threshold Alarms notify users when conditions (such as 
temperature and relative humidity) are outside acceptable 
limits.

Threshold alarms are not enabled by default. To trigger 
threshold alarms when certain thresholds are exceeded, 
users with assigned permissions must configure them. 

Communication Alarms

Communication Alarms notify users when communication 
between a host (Device Host or viewLinc Server) and its 
devices is down. This may be because viewLinc Server can 
not communicate with the device, or the device connection to 
a host has been severed. Communication alarms serve as a 
system health test, alerting you if there is a problem that 
might disrupt viewLinc monitoring and alarming. 
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Event Log Validation Alarms

An Event Log Validation Alarm indicates when changes have 
been made to the event log from outside the viewLinc 
system. Each entry in the event log has its own CRC which is 
verified - if any changes have been made, an alarm is 
automatically created, rendering data non-validatable. It 
checks the CRC of event files, checks the CRC of event 
records in the files, checks for missing records, and checks 
for missing files.  If any are discovered, an alarm is raised 
and must be acknowledged.

Device Configuration Alarms

If you receive a Configuration Alarm, this indicates that your 
device has stopped recording data history or was configured 
incorrectly. This could be the result of being set to stop when 
full, a delayed start, or the device could have an internal 
error. This alarm can also be triggered if a channel has been 
disabled in the device using vLog. To correct this issue, you 
can verify or modify the Vaisala Veriteq device settings using 
vLog. If the problem persists, contact your Vaisala technical 
support representative.

Device Validation Alarms

If you use a VL-type data logger, you’ll receive a Validation 
alarm if the validation memory in the device is corrupted or 
has been modified. Contact your Vaisala technical support 
representative.

Device Calibration Alarms

If you use a VL-type device, Calibration Alarms send you 
intermittent notification when your device is due for 
calibration. You receive notifications at the following intervals: 
3 months and 1 month before the calibration due date, then 
again on the data logger’s scheduled recal date. This alarm 
will remain active until the logger has been recalibrated.

What Happens When an Alarm is Triggered?
When an alarm is triggered, several things can happen:

• A pop-up can appear showing a description of the 
condition, and an alarm message. If pop-ups are blocked 
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in your browser, an error message appears, prompting you 
to enable pop-ups for viewLinc.

• An email can be sent. If configured, emails are 
automatically sent to the address, addresses, or user 
specified when threshold limits are exceeded, 
communications are interrupted, or an event log or device 
alarm condition is present. Alarm emails can be sent 
repeatedly based on how alarm properties have been set.

• An application can be launched or an external device 
turned on. If configured, an external device (such as a light 
or buzzer) or a computer application (such as batch file 
which can page or phone a particular number) can be 
triggered when an alarm condition occurs.

• All of the above. You can also set up a tree alarm 
hierarchy, a method of notifying different individuals of an 
alarm if the first notification is not acknowledged within a 
specified time frame. 

Alarms should be dealt with as soon as possible by 
acknowledging them in viewLinc. All transactions are 
recorded in the Event Log and Historical database and can 
be viewed in an Event Log or Alarm report.

Creating Alarm Templates
viewLinc provides you with six default alarm templates, one 
each for threshold alarms, communication alarms, event 
tampering alarms, and three types of device alarms 
(calibration, validation, and configuration). You can modify 
the parameters of these templates as you need, or create 
your own.

Templates are a great way to save time when you want to 
define similar alarm settings for multiple device channels 
(applies to the general parameters - color code, alarm 
message, delay, acknowledgement, as well as notifications 
and comments).

You can also create a reusable threshold condition and 
assign it to a specific alarm template.
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To create an alarm template:

1 From Options | System Configuration | Templates | 

Alarm Templates, click the Options dropdown, then 

select Add Alarm Template.

2 By default, the alarm template name is New Alarm 
Template. Click in the title to enter a more specific title.

3 On the General Parameters tab, define the following:

a Color Code. Choose the alarm color code - either blue, 
yellow, orange, or red. This color is used as the color 
indicator for alarms on the Alarms tab, and as the 
background color for a row in locations, if activated. It 
is also used as the color for a threshold line in a real-
time graph. Use the color codes to indicate severity, 
starting with blue for less serious alarm conditions, es-
calating to red for the most serious alarm conditions. 

b Alarm Message. If you want to set up an alarm email 
notification (set up on the Notifications tab), enter the 
message you want to appear in the alarm notification.

c Delay Before Activating Alarm (HH:MM). If desired, 
specify a delay period, in hours and/or minutes, from 
when a condition exists and you want the alarm trig-
gered.

d Acknowledgement Required. Select this option if you 
require an individual to acknowledge an alarm. If you 
select this option, the alarm will remain on the Alarms 
tab until it has been acknowledged.

4 If you want the alarm to open in a pop-up window:

a Select the Notifications tab.

b Click Add, and then select Add Pop-up Notification.

c In the Delay before pop up field, indicate a delay, in 
hours and/or minutes (HH:MM), before you want the 
pop-up to display. This delay starts after the delay on 
the General tab finishes.
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Note: We recommend that you use this feature spar-
ingly. If many pop-ups are triggered at the same 
time, it can disrupt your browser operation and 
may require that you restart your browser to cor-
rect.

5 To send an email notification when the alarm triggers:

a Select the Notifications tab.

b Click Add, and then select Add Email Notification.

c In the Delay before sending first notification field, indi-
cate a delay, in hours and/or minutes (HH:MM), before 
you want the first email sent.

Note: If you have set the Delay Before Activating Alarm 
option, ensure the combined time delay does not 
interrupt your alarm notification requirements. 

d To enter a specific email or multiple email addresses 
to receive notification (ones that are not pre-config-
ured in System Configuration | Users), enter the email 
addresses in the Send email to text box. Separate mul-
tiple email addresses with commas.

Note: Email addresses specified in Send email to are 
not checked against email addresses for specific 
users. If you put an email address in Send email 
to, and that same email address is specified in 
System Configuration | Users with a specific 
contact schedule, viewLinc will ignore the sched-
ule and send the notification. 

e Click the User List text box to view a list of users au-
thorized to receive notifications. Only the users with an 
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email address specified in Options | System Configura-
tion | Users are visible (see “Editing Users and Pass-
words” on page 54). Drag users to notify to the 
Selected Users column. Reorganize the list order if 
necessary using the arrow buttons. Click OK.

f In the Repeat email notification drop-down, choose an 
appropriate interval for the frequency emails are re-
sent while the condition still exists. You may also want 
to use the Maximum Number of Repeats field to specify 
a maximum number of repeat emails that should be 
sent (enter zero, 0, if you do not want to specify a limit.  
This will allow infinite repetition).

g To also have an email sent when an alarm is acknowl-
edged, or when the condition no longer exists, select 
the appropriate check box.

h If you want to issue alarm notifications to different re-
cipients for different alarm conditions, create multiple 
email notifications with different delay periods. For ex-
ample, you could create a notification for the first recip-
ient with a short delay period, perhaps 1 minute. 
Create another email notification for someone else 
with a different delay period, for example 20 minutes. 
If the first notification is not acknowledged within 
20 minutes, the second notification is automatically 
sent.

Note: There is additional information that can be sent 
in the alarm email. For more, see “Editing Alarm 
Email Templates” on page 50.
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6 You can also run commands on the viewLinc Server 
machine (which in turn can trigger external devices) 
when a condition exists. To configure commands:

a Select the Notifications tab.

b Click Add, then select Add Command Notification.

c To specify a delay before the command runs, enter a 
delay period in hours and/or minutes (HH:MM).

Note: If you have set the Delay Before Activating Alarm 
option, ensure the combined time delay does not 
interrupt your alarm notification requirements. 

d In the Run command text fields, enter DOS commands 
in the appropriate boxes. You can run different com-
mands when an alarm is triggered, a notification is re-
peated, an alarm is acknowledged, or an alarm 
condition is no longer true. 

For example:

C:\Program Files\Veriteq Instru-
ments\viewLinc\python\python” -m view-
Linc.scripts.SwitchBbRelay <number of 
com port where relay device is attached> 

Option as specified in script documentation in Appen-
dix: FAQs & Troubleshooting. 

The example above shows a python script specific to 
a Digital Relay I/O device. Different parameters apply 
to different commands or scripts. 

7 To insert comments in an alarm email, you can select 
from a list of preconfigured comments (see  “Editing 
Alarm Email Templates” on page 50), or enter a new 
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comment. How comments appear in an email is defined 
in the email template. 

a Select the Comments tab.

b Select a preconfigured comment that is appropriate for 
the purpose of the notification or manually enter a new 
comment you want displayed in the notification. 

8 You can also list all locations and devices that are 
currently using the selected template by clicking Options 
| Devices and Locations using Template.  This shows all 
devices using the selected template and displays their 
zone/location and permissions information.When alarm 

settings are complete, select Options |  Save.

You can now apply this alarm template to one or more 
devices or locations (see “Setting Threshold Alarms” on 
page 86 or “Setting Communication Alarms” on page 90). If 
you want to make minor changes to the template while 
applying to devices, see “Editing Threshold Alarms” on 
page 88, “Editing Communication Alarms” on page 92, or 
“Editing Device Alarms” on page 94.

To create a threshold condition template:

1 From Options | System Configuration | Locations Manager 

| Threshold Templates, click the Options dropdown, 

then select Add Threshold Template.

2 By default, the template is named Default Threshold 
Template. Double-click anywhere in the title to change it.

3 Set the threshold condition.
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4 If you want to apply an existing alarm template (which 
defines how the alarm displays and who is notified when 
a threshold is reached), select Use Alarm Template (see 
“Creating Alarm Templates” on page 80).

5 If you want to define custom settings for this template, 
complete the fields in the General Parameters, 
Notifications, and Comments tabs. This option is also 
available using the right click context menu while a 
template is highlighted.

6 When you are finished creating your threshold template, 
click Save.

Threshold Alarms
Users with the correct permissions set device channel 
thresholds that trigger alarms. For example: 

• Greater than 23.00 C for more than 1 minute

• Less than 37.76 RH for more than 15 minutes

You can set a threshold alarm using a template (if previously 
configured), or set a custom alarm.

Setting Threshold Alarms
You can configure several threshold alarms, for example, one 
for yellow alarms (mild concern), another for red alarms 
(extreme concern). For example, you could set a yellow 
alarm to trigger first (at one minute out of threshold), and 
send an email to someone who needs to know. For a red 
alarm, you could set the alarm condition to a longer time 
(15 minutes out of threshold) and send the email to a lab 
manager, or a distribution list of people who need to be 
notified to take action. 
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To set a threshold alarm:

1 From Options | System Configuration | Locations Manager, 
select the location or locations you want to set the 
threshold alarm for.

Note: To select multiple locations at one time, hold 
down the [Ctrl] key while you select locations. To 
select a group of locations in a list, hold down the 
[Shift] key and select the first and last locations. 
The Locations Properties panel will update auto-
matically.

2 Select the Thresholds Tab, click the Options dropdown 

from the Location Properties panel and click  Create X 
Threshold (where X represents the unit reading 
measured at this location, such as C or RH or mA). 
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The Edit Threshold screen appears.

3 To set a threshold alarm using an existing threshold 
template (recommended), select Use Threshold 
Template, then select the template from the drop-down 
list.

4 To set a custom threshold, select Use Custom Threshold 
Settings and define the threshold condition. For example, 
a temperature alarm that is triggered when the 
temperature goes above 21C.

5 To use an existing alarm template, select Use Alarm 
Template, then select the template from the drop-down 
list.

6 To set up custom alarm settings, select Use Custom 
Alarm Settings. 

7 Set your alarm settings on the General Parameters, 
Notifications, and Comments tabs following steps 3 
through 8 in “Creating Alarm Templates” on page 80.

Editing Threshold Alarms
To edit a threshold alarm:

1 In Options | System Configuration | Locations Manager, 
select the location you want to edit thresholds for, then 
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select the threshold to edit from the Thresholds tab in the 
Location Properties panel on the right.

2 Select Options | Edit Threshold. The Edit Threshold 
screen displays. 

3 Edit threshold settings as desired.

4 Click Save. 

Disabling Threshold Alarms
You can temporarily disable alarms without deleting all the 
setting information (for example, when you want to move a 
device from one location to another).

To temporarily disable a threshold alarm:

1 In Options | System Configuration | Locations Manager, 
highlight the row of the location you want to disable 
thresholds for. 

2 On the Threshold tab of the Location Properties panel, 
select Options | Edit Threshold.

3 In the Edit Threshold screen, deselect Enable Threshold 
Alarm.

4 Click Save.
Note: You can also pause alarms - for more informa-

tion, see “Pausing Alarms” on page 97.

Deactivating and Reactivating Threshold Alarms
You may want to deactivate a device’s threshold alarm 
because it is no longer required. A deactivated threshold 
“disappears”, but can be reactivated.
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To deactivate a threshold alarm:

1 Select Options | System Configuration | Locations 
Manager and highlight the row of the location you want to 
deactivate the threshold alarm for. 

2 On the Threshold menu, select Deactivate Threshold.

To reactivate a deactivated alarm:

1 Click the Options dropdown and select Show Deactivated 
Items.  The checkbox will appear checked when 
deactivated items are being displayed.

2 From the list of thresholds that appear highlight the one 

you’d like to reactivate, right click and select  
Reactivate Threshold.

Note: You can also pause alarms - for more informa-
tion, see “Pausing Alarms” on page 97. 

Communication Alarms
Communication between devices and the viewLinc Server is 
essential for real-time monitoring of conditions. Because of 
this, viewLinc includes communication alarms to notify users 
if communications are down at any point. By default there is 
one communication alarm preconfigured for each host and 
each device. You can either edit the default alarms, or set up 
additional communication alarms.

Setting Communication Alarms
To set a communication alarm:

1 From Options | System Configuration | Device Manager, 
navigate the Device Browser tree and select the host or 
device you want to set the communication alarm for.
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2 To set a Host Communication alarm, click Options | Host 
from the device browser panel and select Host 
Communication Alarm Settings. 

3 To set a Device communication alarm, click Options | 
Device | Device Alarm Settings and select Device 
Communication Alarm Settings.

The Communications Alarm Settings screen appears.

4 Select Enable Alarm (an alarm is not ‘live’ until it is 
enabled).
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5 To set a communication alarm using an existing alarm 
template, select Use Alarm Template, then select the 
template from the drop-down list.

6 To set custom alarm settings, select Use Custom Alarm 
Settings.

7 Set your alarm settings on the General Parameters, 
Notifications, and Comments tabs following steps 3 to 8 
in “Creating Alarm Templates” on page 80.

Editing Communication Alarms
By default, there is one communication alarm preconfigured 
for each host and device. These alarms cannot be deleted; 
however, they can be edited. 

To edit communication alarms:

1 From Options | System Configuration | Device Manager, 
navigate the Device Browser tree and highlight the name 
of the host or device whose communication alarm you 
want to edit.

2 To edit a Host Communication alarm, click Options | Host 
from the device browser panel and select Host 
Communication Alarm Settings.

3 To edit a device communication alarm, click Options | 
Device | Device Alarm Settings and select Device 
Communication Alarm Settings. The Communication 
Alarm Settings screen appears. 

4 Edit alarm settings as desired.

5 Click Save. 

Disabling Communication Alarms
You can temporarily disable communication alarms without 
deleting all the setting information.

To temporarily disable alarms:

1 From the Locations tree in Locations Manager, highlight 
the name of the host or device whose communication 
alarm you want to disable.
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2 On the Host or Device menu, select Communication 
Alarm Settings. The Communications Alarm Settings 
screen appears. 

3 Deselect the Enable Alarm check box.

4 Click Save. 
Note: You can also pause alarms - for more informa-

tion, see “Pausing Alarms” on page 97.

Device Alarms
Ensuring the continuous functionality of your device is 
required for accurate real-time monitoring. Because of this, 
viewLinc includes device calibration, validation and 
configuration alarms to notify users if device functionality is 
compromised at any point. By default, there are three device 
alarms (in addition to the Device Communication alarm) 
preconfigured for each device. These alarms cannot be 
deleted; however, they can be edited.

Setting Device Alarms
To set a device alarm:

1 From the Device Browser in Options | System 
Configuration | Device Manager, select the device you 
want to set the device alarm for. 

2 On the Options | Device menu select Device Alarm 
Settings, then select the device alarm type you want to 
set. The Alarm Settings screen appears. 
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3 Select Enable Alarm (an alarm is not ‘live’ until it is 
enabled). 

4 To set a device alarm using an existing alarm template, 
select Use Alarm Template, then select the template from 
the drop-down list. 

5 To set custom alarm settings, select Use Custom Alarm 
Settings and use the General Parameters, Notifications, 
and Comments tabs to define custom settings (see steps 
3 through 8 in “Creating Alarm Templates” on page 80). 

Editing Device Alarms
To edit a device alarm:

1 From the Device Browser in Options | System 
Configuration | Device Manager, select the device you 
want to edit the device alarm for. 

2 On the Device menu select Device Alarm Settings, then 
select the device alarm type you want to edit. 

3 Edit alarm settings as desired.

4 Click Save.

Disabling Device Alarms
To disable a device alarm:

1 From the Device Browser in Options | System 
Configuration | Device Manager, select the device you 
want to disable. 

2 On the Device menu select Device Alarm Settings, then 
select the device alarm type you want to disable. 

3 Deselect the Enable Alarm check box.

4 Click Save. 
Note: You can also pause alarms - for more informa-

tion, see “Pausing Alarms” on page 97.

Acknowledging Alarms
All users can receive alarms, but only users with the correct 
permission can acknowledge alarms.
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If an alarm is set to require alarm acknowledgement, alarms 
must be acknowledged. You must be logged in to viewLinc to 
acknowledge alarms. 

Acknowledgement information, such as the action taken and 
any comments, is tracked in the Event Log and Historical 
database. For more information, see Chapter 7: Events and 
Chapter 8: Reports.

Alarms can also be configured so they do not require 
acknowledgement. See “Setting Threshold Alarms” on 
page 86, “Setting Communication Alarms” on page 90, and 
“Setting Device Alarms” on page 93 for more.

When an alarm is triggered, a new row appears in the 
location alarms tab.

This section covers acknowledging alarms using the location 
alarms tab. You can also acknowledge alarms from

the “Alarms” form (Options | Alarms) or from a large popup 
trend view (see “Acknowledging Alarms from Large Popup 
Trend View” on page 75).

To acknowledge alarms from the location alarms tab:

1 From Options | Locations, select a location or zone.  Click 
on the Location Alarms tab, select the active alarm, then 

right click and select Acknowledge. 

Note: The number after the location name (i.e. Temper-
ature (15494) is the unique location ID.  In case 
the locations have been given the same name, 
this number provides a unique ID so you can dif-
ferentiate between them.
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2 The Acknowledge Alarm dialog box appears, prompting 
you to enter actions taken and comments. 

3 Click Acknowledge. Your comments and actions are 
added to the Event log and the Acknowledge Alarm box 
closes. Locations are updated with this change in status.

To acknowledge alarms from the alarms list:

1 Click Options | Alarms to view the list of active alarms.

2 Select the Alarm you wish to acknowledge.  If you wish to 
acknowledge multiple alarms, you can hold the [Ctrl] or 
[Shift] buttons and click to multiple select then right click 
and select Acknowledge, or click the Options dropdown 
and select Acknowledge.  You may wish to uncheck the 
“Auto Refresh On” checkbox when multiple selecting as 
the auto refreshing can delay the selection process.

3 If you wish to acknowledge all active alarms, you can use  
the Options dropdown and select Acknowledge All Off 
Alarms.  Multiple selecting is not required in this case. 

4 The Acknowledge Alarm dialog box appears, prompting 
you to enter the actions taken and comments. 

5 Click Acknowledge. Your comments and actions are 
added to the Event log and the Acknowledge Alarm box 
closes. Locations are updated with this change in status.
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Pausing Alarms
You may want to pause alarms if you need to move devices, 
or if a certain known situation may result in conditions 
exceeding set thresholds. Pausing alarms is faster than 
disabling alarms for a temporary period. You can pause an 
alarm for up to 24 hours.

To pause all alarms in a zone:

 Select Options | Alarms.  This list will automatically 
refresh with the most current alarms as long as the Auto 
Refresh checkbox remains checked.  You can select the 
attributes that will be available for viewing in this panel by 
clicking the down arrow next to any column heading and 
toggling the checkbox beside the item.  The column can 

then be sorted by clicking on the column header to group 
the respective column items together.

Exporting alarms to Excel format:

 Click the Options dropdown and select Export to Excel.  
This will export all alarms in this list to a .tsv format file.  
When prompted, save or open this file from your 
browser. 

To print all active alarms:

 Click the Options dropdown and select Print.  A new 
browser tab will appear with a printer-friendly list of 
alarms and the print dialog will pop up.  Choose your 
desired print settings and print the document.
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Chapter 6: Permissions

This section includes:

• Information about User Permissions, User Rights and 
Access control lists

• How to create users, assign them to groups and zones, 
add permissions and control rights.
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About Permissions
viewLinc 4.0 provides several new security options and 
introduces the concepts of groups, users and zones.  These 
features provide quicker methods of configuring permissions 
for multiple users and subsequently adding individual user 
permissions as needed.

viewLinc 4.0 also provides the ability to add an access 
control list to a particular zone then give a group permissions 
specific to that zone.
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Creating New Groups, Users and ACL’s

Creating a New Group
1 Select Options | System Configuration | Groups.

2 Select  Add Group from the Options drop box in the 
Groups window.

3 Complete the Group Name and Description fields with 
the appropriate information. 

4 Expand the Rights view by clicking on the lower bar 
labelled “Rights”.

5 Click the Add Right button and select the rights required 
for this group by clicking the checkboxes under the 
Select column, then click OK.
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6 Expand the Members view by clicking Members then 
click the Add User button.

7 Select the users to be included in this group by clicking 
all required checkboxes, then click OK.  The members of 
the selected groups and their group rights should now 
appear under the Member section in the accordion view.
Note: The Add Groups functionality is available only for 

users with ‘Manage System’ rights. Admin (or a 
user with ‘Manage System’ rights) can create 
groups defining their global access rights for the 
application.

Deactivating/Reactivating a Group
1 Select Options | System Configuration | Groups.

2 Select the group you wish to deactivate/reactivate.

3 Select the Options dropdown box in the Groups window 
and select  Deactivate Group.  

4 If the group needs be reactivated, the Options | Show 
Deactivated Groups checkbox must first be checked. 
Follow the same process as above but select 

Reactivate Group as the final step.

Creating a New User
1 Click the Options button and Select System Configuration 

| Users.

2 Click on the Options drop box in the Groups window and 
Select  Add User.

3 Complete the Login Name and Email fields with the 
appropriate information.  Click the Schedule dropdown 
box for pre-set contact schedules.  See “About Contact 
Schedules” on page 53.
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4 Set the password manually by entering and confirming it, 
or click the Windows Authentication checkbox in order to 
make the user’s password the same as their windows 
password.  
Note: For this functionality to work, the login name field 

must match an existing windows login. Use 
standard windows login naming delineated by 
the “/” character where appropriate.

5 Expand the Rights view by clicking on the lower bar 
labelled “Rights”.

6 Click the Add Right button and select the rights required 
for this user by clicking the checkboxes under the Select 
column, then click OK.
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7 Expand the Groups view by clicking the Groups bar then 
click the Add Group button.

8 Select the groups to be included in this group by clicking 
all required checkboxes, then click OK.  The members of 
the selected groups and their group rights should now 
appear under the Member section in the accordion view.

9 Click Save. 

Note: viewLinc offers the ability to have users re-con-
firm their identity by re-entering their user name 
and password either whenever a change is 
made, or after a set number of minutes. To set 
this preference, see “Setting Session Expiry 
Time” on page 57.

Adding an ACL to a Zone 
The Access Control tab in Locations Manager allows you to 
view and add permissions to a specific zone or location.  This 
functionality compliments the existing user and groups 
permissions allowing for greater customization and flexibility. 
Access control is displayed in a grid format where user and 
groups ACL’s are assigned for zones and locations. By 
assigning an ACL, it’s possible to control the permission level 
of each user or group in the Locations tree. By default, ACL’s 
added to a node are automatically inherited by all child 
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nodes/locations unless otherwise specified by the user. The 
system will resolve any conflicting permissions by applying 
the highest permission and removing the lower ACL when 
changes are saved. 

viewLinc offers several access control privileges, as outlined 
in the following table: 

Security Level Privileges

Full Control • full privileges
• in viewLinc 3.4 and previous, 

this was an “Administrator” 
account

• sees all channels (cannot 
assign or limit channels)

Configure Alarms • same as Configure Custom 
Thresholds and can configure 
alarms

• sees all channels (cannot 
assign or limit channels)

Configure Custom Thresh-
olds

• same as Acknowledge Alarms 
and can configure alarm 
thresholds

Acknowledge Alarms • same as View and can 
acknowledge alarms

View • show and hide zones
• view, edit, print and sort event 

logs
• generate alarm and historical 

data reports
• can be assigned a limited set 

of channels to view

Table 1: Privileges associated with each viewLinc User 
Security Level
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To Add an ACL to a Zone

1 Select Options | System Configuration | Locations 
Manager.

2 Navigate to the zone you’d like to specify access to by 
using the Locations tree. Select a location.  

3 Click the Access Control tab to see the current 
permissions for the zone.

4 If you wish to see the permissions which are inherited 
from the parent zone, click Options | Show Inherited from 
the Location Properties panel and the list will update to 
show those permissions as well as any existing 
permissions in the zone.

5 Click Options |  Add from the Location Properties panel 
to add a new access control.

6 Select an access control type, user name, and type of 
permission you wish to give.  You can also select 
whether all child zones and locations will also inherit this 
ACL with the “All child zones inherit this ACL” checkbox.
Note: If you select this option when the user has view/

full control rights, it will enable the user/group to 
view all subfolders within the zone/location.  
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Therefore it should remain unchecked if the 
user/group should not view the information in 
any of the subfolders. Access should instead be 
given to these subfolders on an individual basis.

7 Click  Save.  The new permission should appear in the 
Access Control list and access to the Location will be 
limited accordingly.  If you wish to see the current 
permissions for other zones, you can select them from 
the Locations tree and the access control list will update 
automatically. Close the Locations Manager.
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Chapter 7: Events

All events - such as alarms, transfers of data from the device, 
alarm acknowledgements, system configuration changes and 
general system notifications - are tracked in viewLinc’s Event 
Log under Options | Events. 

The data tracked in Events is different from the data tracked 
in a device. Where the viewLinc Event Log tracks events 
occurring within the viewLinc system (such as notification of 
successful transfer of data from a device to a stored local 
directory), the device itself tracks the changes in 
temperature, relative humidity or voltage. 

To ensure viewLinc continuously monitors and stores event 
history, event log validation alarms notify you when the 
viewLinc event log has been modified. For more about event 
log validation alarms, see Chapter 5: Alarms.

Use the Events function to analyze events and determine 
when and where particular problems occurred, or to 
diagnose a situation that needs troubleshooting. 

In this section, you’ll learn to:

• View events

• Add comments to events

• Print event logs

• Export and save event log data into .tsv format
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Viewing Events
Events are viewed in an Event Log, a text-based listing of all 
system events occurring with the devices on your system.

To view Events:

1 From viewLinc, select Options | Events. The Event Log 
appears, displaying a list of events, and, if available, 
comments on the event in the Event Details area to the 
right of the event listing. 

2 Using the date and time selectors, choose the period for 
which you want to see events. Enter a date (using format 
MM/DD/YYYY HH:MM) or use the calendar button to 
specify a date range. 

3 Using the buttons to the right of the date and time 
selectors, select or deselect buttons to see specific types 
of event details. After selecting an event type button to 
filter your results, select Options |  Refresh to refresh 
the list. The more buttons you deselect, the shorter the 
list will be. You can choose to view:

• Alarm Events. A list of alarms that were triggered during 
the specified time period.

• Admin Events. A list of administrator actions taken, 
such as logging in to viewLinc and new alarm threshold 
settings.

• Transfer Events. List of device data transfers performed 
during the specified time period.

• System Events. List of changes to configuration options 
or any failed attempts to communicate between 
viewLinc Servers and devices.

4 Filter the results by clicking on the Filters dropdown in 
the upper right corner.  You can select or unselect 
different event types (Alarm, Admin, Transfer and 
System Events) by toggling the checkboxes associated 
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with them.  You can also filter by specific users, groups or 

locations by clicking accordingly then checking or 
unchecking the checkboxes for the desired users, groups 
or locations.  Select Options |  Refresh to refresh the 
list or click outside of the filters window and the list will 
refresh automatically.

Adding Comments to Events
You may want to add comments to the Event Log, perhaps to 
outline why an event occurred or what was done in response 
to an event or problem. 

To add a comment to the Event Log:

1 From viewLinc, click Events.

2 Highlight the row (event) to add the comment to, and 
select Options | Add Comment. The Add Custom 
Comments to Event screen appears.

3 Enter your comment, then click Save.

4 To view a comment for a particular event, highlight the 
row containing that event and look for the comment in the 
Event Details area.
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Adding Custom Events
You may want to add comments to the Event Log, perhaps to 
outline why an event occurred or what was done in response 
to an event or problem. 

To add a custom event:

1 From viewLinc, select Options | Events.

2 From the events window, select Options | Add Custom 
Event.

3 Fill in the custom event message and details, then press 
Save.

Printing Event Logs
To print the event log:

1 From viewLinc, select Options | Events.

2 Choose the date and time range you are interested in 
printing. In the date/time box, enter a date and/or time in 
24-hour notation, or click the calendar icons to make 
your selection.   

3 Using the buttons to the right of the date and time 
selector, choose to either include or not include Alarm 
Events, Admin Events, Transfer Events and/or System 
Events.

4 From the events window, select Options | Refresh. 

5 From the events window, select Options | Print. 
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6 In a new browser window, a printer-friendly Event Log 
report opens. 

7 The Print dialog box displays automatically allowing you 
to set your print parameters and print the Event Log.

Exporting Event Logs 
With viewLinc you can export event log data into a saved .tsv 
file for analysis at a later date.

To export event logs:

1 In viewLinc, click Options | Events and choose the 
date range you are interested in exporting. In the date/
time box, enter a date and/or time in 24-hour notation, or 
click the calendar icons to make your selection. 

2 Click the  Filters dropdown to the right of the date and 
time selector to choose different event types by checking 
or unchecking Alarm, Admin, Transfer, and/or System 
Events.

3 Click Options | Refresh. 

4 Click Options |  Export to Excel. A file download 
dialog opens, prompting you to open or save the events 
.tsv file (in Microsoft Excel format). 
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Chapter 8: Reports

Using viewLinc, you can create graphs and reports to 
analyze changes in data over time based on the historical 
data collected by Vaisala devices. 

In this section, you’ll learn what historical data is and how to:

• Analyze historical data

• Generate historical data reports in graphical and tabular 
formats

• Create new reports and report templates

• Delete reports
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About Reports
Vaisala devices have the ability to store large amounts of 
data inside them. Data is logged in frequencies from once 
every 10 seconds to once every 24 hours. To set this 
frequency (known as the sample interval) for Vaisala Veriteq 
devices, refer to your vLog product guide. To set the sample 
interval for 300 Series Transmitters refer to the specific 
Vaisala product guide. Also see “Editing Device Properties 
and Aliases” on page 45.

With viewLinc you can monitor real-time conditions for 
devices over the network, analyze or graph changes in 
conditions over time, or compare conditions recorded by 
different devices. This analysis is performed using the 
Reports function. 

Historical data from a Vaisala Veriteq device can also be 
transferred to a local directory on a set schedule - be it daily 
or weekly - using viewLinc’s Transfers tab. Once transferred, 
data can be retrieved for exporting (into .tsv) and printing, 
depending on your reporting needs. See Chapter 9:  
Transfers for more.

Generating Historical Data Reports
viewLinc provides you with a set of graphical reports which 
can help you easily view trends in data readings or alarm 
monitoring statistics (such as alarm trigger frequency).

•   Alarm reports provide an overview of alarm events 
over a period of time (events related to every alarm are 
grouped together and presented in a readable form).

•   Historical data reports provide a detailed history of 
location values (presented in both graphical and tabular 
form).
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Generating Alarm History Reports
To generate an Alarm history report:

1 Select Options | Reports and left click to select the report 
you want to generate from the Report Definitions tree. 

The report parameters appear on the right side of your 
screen (users can only view report parameters for the 
reports they generate, or reports to which they have 
been granted owner access). 

2 Select an Alarm. On the General tab you can specify the 
period you want the report to include using the default 
option, Most Recent Events, or a specific date range. If 
you choose a fixed date range from the Range Type 
dropdown, calendars will appear to indicate from/to 
dates.If you have Admin access, you can select a Report 
Owner, the user you want to have access to modify or generate 
this report (to set up a list of users see, “Editing Users and 
Passwords” on page 54).

3 In the Scheduled Generation area of the General tab, 
you can choose the format for your report (PDF or tab-
separate, for Excel), to automatically generate and save 
the report to a specific file location, or send the report to 
an email address or a list of addresses (use a comma to 
separate email addresses). You can also schedule when 
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you want the report to generate, and how frequently you 
want it generated.
Note: For large report data sets, we recommend that 

you schedule report generation at a time when 
few users are using the system, such as after 
business hours.

4 On the Content tab determine whether you want a brief 
report (with one line for each alarm) or a detailed report 
(showing details about all alarm activities: activation, 
notifications, acknowledgement, etc.).

5 On the Source Data tab define the report scope. To 
include alarm report details from all locations, select All 
Locations. You can also select specific locations and 
zones:

a Select the option, Selected Locations and Zones.

b To select all locations in a zone, select the checkbox 
corresponding to the zone name from the locations 
tree. 

c To select a specific location in a zone, expand the tree 
to find the location, then select its checkbox. 

d Repeat these steps for each location you want to in-
clude on the report. All selected locations appear in 
the Selected region.

6 On the Page Layout tab define your report display 
options:

a Page Header and/or Page Footer options: choose the 
pages on which you want a header or footer displayed. 
To define the header or footer, enter text in the Left, 
Center or Right fields.

b Choose the type of paper you want to print on and the 
orientation.

c You can also choose a customized icon in the left 
header section by clicking “Upload” or select from a list 
of provided icons by clicking the Image File dropdown.

7 From the reports window, select Save.

8 To manually generate the report, choose either Export to 
Excel (which will generate a .tsv format file) or Generate 
PDF Report (which generates an Adobe format .pdf file) 
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from the options dropdown. The  exclamation point 
icon indicates when you have made changes that need 
to be saved. 

Generating Location History Reports
To generate a Location History report:

Note: viewLinc does not provide a default Location 
History report. Instead, the first time you gener-
ate a Location History report, the report is auto-
matically saved.

1 Select Options | Reports. In the Report Definitions tree, 
select the report you want to generate from the Locations 
History Reports section. The report details will appear on 
the General tab in the right panel.

2 On the General tab, specify the user you want to have 
access to this report (if not already granted Full Control), 
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and the range type data based on a specific date range, 
or the most recent data. 

3 In the Scheduled Generation area, you can choose the 
format for your report (PDF or tab-separate, for Excel), to 
automatically generate and save the report to a specific 
file location, or send the report to an email address or a 
list of addresses (use a comma to separate email 
addresses). You can also schedule when you want the 
report to generate, and how frequently you want it 
generated.
Note: For large report data sets, we recommend that 

you schedule report generation at a time when 
few users are using the system, such as after 
business hours.

4 On the Content tab identify the types of data you want 
included in the report, including Trend Graph, Title Page, 
Interval statistics graph (this allows you to change 



Generating Historical Data Reports

viewLinc 4.0 Administrator Guide 121

Statistic Settings in the Statistic Settings tab), and/or 
Tabular Data.  

5 If you include the Interval Statistics graph, use the 
Statistics Settings tab to define how information will 
display on your report, and any statistical information you 
want to include:

a From Statistics Settings, select a statistics interval by 
checking the Include statistics at intervals checkbox if 
you want to intermittently generate statistics within the 
time frame of a report. For example, if your report gen-
erates data based on a seven day (weekly) interval, 
you may want to view statistics daily by selecting the 
Specify Duration radio box and specifying 1 day, 0 
hours.

b In the Include area, select the types of statistical data 
you want to add to the report, including maximum val-
ue, average value, minimum value, standard devia-
tion, sample count and mean kinetic temperature 
(MKT):

• If you want to specify the activation energy, check 
Mean kinetic temperature and specify the 
activation energy as KJ/mol.

6 On the Source Data tab, define the report scope and 
color spectrum. To report on all locations, select All 
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Locations. The screen will become greyed out to indicate 
that all are included.  You can also select specific 
locations and zones:

a Select the option Selected Locations and Zones.

b To select one or more locations in a zone, check the 
checkbox next to the zone or expand the zone and 
check the checkbox next to the location name. 

c To add an index to the graph, select Show Markers. 

d To  specify a color to highlight a specific location’s da-
ta, select the location, then select an option from the 
color dropdown. If you select Auto, viewLinc chooses 
a color according to the default color spectrum:

e When the location line colors are set to ‘Auto’ viewLinc  
assigns the next free color from a built-in palette of col-
ors (see page 145 for the color spectrum sequence). 
Repeat for each location you want to include on the re-
port. All selected locations appear in the Selected re-
gion. 
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7 Use the Page Layout tab to define the headers, footers, 
paper size and orientation:

a For Header or Footer options, choose to display on all 
pages, on the first page only, on the last page only, or 
on the first and last page.

b To define the content of your header or footer, enter 
text in the Left, Center or Right fields.

c You can also choose the paper size you want to print 
on and the orientation (portrait or landscape).

d Select a header image by using the Image File drop-
down (for previously used images) or upload a new im-
age file by clicking the Upload button and clicking 
Browse to locate the file.

e Select Options | Save.

f To manually generate the report, click the options 
dropdown and select Generate PDF Report.

Creating New Reports
viewLinc provides you with a set of default report templates 
which you can modify according to default criteria. You can 
also save your modifications as a new report template for 
others to use.

If you want to make extensive modifications to the standard 
report template, use the New Location History report or New 
Alarm report functions. If you want to define a new report 
which is similar to an existing report template, use the Clone 
Report feature.

To create a new Alarm History or Locations History report:

1 In the Reports toolbar, select the button for the type of 
report you want to create:  New Alarm Report, 

 New Location History Report, or Clone Report.

2 Complete the report parameters as you want them to 
appear.

3 To assign a new name for the report (by default it 
generates a name based on selected parameters), click 
on the title to make the text editable, and enter a name.

4 Select Options | Save.
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Your new report is saved and appears alphabetically in the 
report list.

Deleting Reports
To delete a report that you no longer use:

1 Select the report you want to delete from the report 
definitions tree.

2 Select Options | Delete. Click OK to confirm.
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Chapter 9: Transfers

This section describes how to:

• Transfer historical data from Vaisala Veriteq devices 

• Create, edit, deactivate and temporarily disable scheduled 
data transfers
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About Transfers and Transfer Schedules
In addition to being able to view your device history in 
viewLinc, you can transfer your Vaisala Veriteq device data 
for viewing and analyzing in a spreadsheet or other data 
analysis tool.

You can transfer Vaisala Veriteq device data according to a 
set schedule. Since transfers can be scheduled in advance, 
you don’t need to be there when the transfer takes place. 
Regardless of how frequently you schedule data transfers, 
data in the device remains intact and is recorded indefinitely 
(or until the device reaches its memory capacity). 

It is recommended that you transfer your Vaisala Veriteq 
device data on a regular basis for backup purposes, and to 
ensure no data is overwritten (refer to the vLog User guide 
for more information on device data storage capacity). Each 
transfer from each device creates one data file per device. 

Note: All Vaisala Veriteq devices are assigned a 
default transfer schedule when the device is dis-
covered. The transfer is enabled and scheduled 
for a seven-day period. If your device will reach 
its storage capacity before this period is over, 
you can adjust the period to ensure no data is 
lost.

Creating Transfer Schedules
To create a transfer schedule for a Vaisala Veriteq device:

1 From viewLinc, select Options | Transfers.

2 Select Options |  New Transfer.

3 From the Device Transfer Properties window, in the 
General area, click Enable this transfer. New transfers 
are disabled by default.
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4 From the Device drop-down, choose the device for which 
you want to set the transfer. 

5 In the “Email notifications to” dialog, enter the email 
zaddress to receive notification should the transfer fail. 
You can choose an email address, a list of email 
addresses separated by commas, or a distribution list 
created on your mail server by the IT administrator.

6 Ensure correct mail server settings have been set in 
“Configuring Email Settings” on page 49.

7 In the Schedule area, choose a transfer schedule interval 
and start date and time. The Start time is a drop-down list 
of 15-minute intervals. For example, you could set up a 
data transfer every 7 days, beginning 2011-11-14 at 
11:15 PM. 

8 In the Destination area, choose the destination directory 
for the saved .spl file (do not use a mapped drive path). 
Sample directory paths could include: c:\device_files or 
\\<machinename>\<destination_dir>. We recommend 
you use a directory on the viewLinc Host Server (for 
example, c:\<destination_dir>). 
Note: During a data transfer, you may be prompted to 

enter a valid username and password for saving 
to the target directory or shared directory. You 
also need to ensure that the account which 
installed viewLinc (that is, which runs the view-
Linc Enterprise Server service) has sufficient 
permissions to write to the directory where you 
want the transferred data to go. For more on Ser-
vices with viewLinc, see “Appendix: FAQs & 
Troubleshooting” on page 137.

9 Choose the filename for your transferred file by 
specifying the order for the identifying fields which will 
make up the filename. Filenames for .spl files are 
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created from combinations of the device's description, its 
serial number, and the date and time the file was saved. 
For example, Device ID-08094523-2011-04-22 16-30-
01.spl.

10 In the comments area, enter either a preconfigured 
comment, or any specific comments you want to 
associate with this transfer, such as its purpose, to whom 
email notifications should go, and so on.

11 To test that the transfer will complete as defined, click 
Transfer Now. The data should be transferred to the 
location specified. 

12 Click Save to save these settings for a scheduled 
transfer.  The add comment window appears if 
comments are enabled from system preferences.  Select 
a preconfigured comment or enter your own. A row 
containing information on the scheduled transfer for each 
device you’ve set up appears in Transfers.

Performing an Immediate Data Transfer
To transfer data now: 

1 Follow steps 1 through 10 in “Creating Transfer 
Schedules” on page 126 (or edit an existing transfer) and 
then click Transfer Now. The data should be transferred to 
the location specified. 

2 Click Save to save the scheduled transfer or Cancel to 
close.

Editing Transfer Schedules
To edit scheduled transfers:

1 From viewLinc, select Options | Transfers.

2 Select the row containing the scheduled transfer(s) to 
edit.

3 select Options | Edit Transfer. 

4 The Device Transfer Properties screen appears. Edit the 
transfer details as required.

5 Select Options | Save. 
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Deactivating a Transfer Schedule
You will need to deactivate any scheduled transfers when 
deactivating devices.

To deactivate a scheduled transfer:

1 From viewLinc, click Transfers. 

2 Select the row containing the scheduled transfer you 
want to deactivate.

3 Click Deactivate Transfer. 

4 A dialog appears, prompting you to confirm the 
deactivation. Click Yes.

To show all deactivated transfers, click Show Deactivated 
Transfers; the deactivated transfers appear in your list in grey 
text.

Temporarily Disabling Transfer Schedules
Disable a transfer schedule when you want to swap a Vaisala 
Veriteq device or no longer want to view a transfer schedule 
in your list of transfers.

To temporarily disable scheduled transfers:

1 From viewLinc, select Options | Transfers. 

2 Select the row containing the scheduled transfer to edit.

3 Click Edit Transfer.

4 From the Device Transfer Properties screen, deselect 
Enable this transfer.

5 Select Options | Save.
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Chapter 10: Mobile UI

This section is for administrators and general users.

In this section, you’ll learn about:

• How to navigate viewLinc 4.0’s Mobile interface

• The types of functions available in the Mobile application

Let’s get started learning about the Mobile interface in 
viewLinc.
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About the Mobile UI
viewLinc 4.0 provides access from Mobile devices, allowing 
you to perform certain key tasks from your smartphone or 
tablet. The look and feel of the mobile application is similar to 
the main UI, however access is limited to certain key 
functions as follows:

• The Locations Panel

• Popup Trends

• Alarms and alarm comments.

The panels under the ‘System Configuration’ menu, transfer 
panels, events, and reports panels are not available and 
must be accessed from the browser UI.

The Mobile UI supports the following mobile devices: 

Apple iOS 3+, Android 2.1+, and BlackBerry 6+ devices. 

The Mobile UI does not support system configuration, 
transfers, events, or reports.  This functionality is only 
available in the main browser UI.

Working with the Mobile UI
When you first load the mobile application, it will prompt you 
to enter a username/password which is the same as the 
browser UI.  The initial screen that appears after login is the 
system level of the locations tree.  The tree is navigated by 
pressing any zone to reveal the locations below it, then 
pressing the top left Options menu to view the commands 
available.

To view a popup trend using the mobile UI:

1 Press the  Locations tree then navigate to the location 
by pressing on the zone containing the location. Press 
the location to highlight it.
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2 Press Options | Popup Trend

3 The Popup Trend window appears.  This window is 
controlled using the same buttons and checkboxes as a 
traditional popup trend window. See “Opening Large 
Popup Trend Views” on page 71. Also see step 9 of 
“Building a Trend with the Trend Tab” on page 67 for how 
to use the blue arrow button controls.

To change popup trend graph settings using the mobile UI:

1 Press Options | Popup Trend with a location selected.

2 In the lower right corner of the popup trend, press  
Options then press on the checkboxes for Realtime 
Samples or Threshold Lines.  

3 Press Done. The graph will automatically update to 
reflect your changes as long as the Auto Refresh On 
checkbox is checked. 
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Acknowledging Alarms with the Mobile UI
To acknowledge an alarm using the mobile UI:

1 Press the  alarms button. 

2 Highlight the alarm you’d like to acknowledge.

3 Press Options | Acknowledge. 

To pause or resume alarming using the mobile UI:

1 Press the  Locations view button.

2 Press a location to pause to pause or resume alarming 
for.
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3 Press Pause X Alarming or Resume X Alarming 
(where X is the type of alarm you’d like to control.)

4 The alarming will remain paused until you toggle it by 
following these steps again and selecting Resume X 
Alarming.
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Appendix: FAQs & 
Troubleshooting

This section contains answers to frequently asked questions 
and information for troubleshooting common problems with 
viewLinc and vNet or Digi devices.  It also contains some 
technical details for administrators and support staff.

As an administrator, you may want to be aware of the 
viewLinc services running on your Windows PC. This section 
also contains information on which files are installed as part 
of viewLinc.

Q: How does viewLinc work?

A: viewLinc runs as a Windows service which is launched 
automatically. If and when you reboot the viewLinc Server, 
this service will automatically start.

The viewLinc Enterprise Server is a service which gathers 
data from devices, performs scheduled transfers, watches for 
alarms, executes any associated actions, manages users, 
and controls system-wide and user-specific settings.

Q: Which HMT Transmitters can I use with viewLinc 4.0?

A: Here is the list of supported 300 Series Transmitters:

HMT331, HMT333, HMT334, HMT335, HMT338, HMT337, 
DMT342. DMT344, DMT345, DMT346, DMT347, DMT348, 
PTU301, PTU303, PTU307, MMT332, MMT337, MMT338.

Q: How do I stop or turn off viewLinc?

A: Complete the following steps:

1 On your Windows PC, choose Start |  Control Panel | 
Administrative Tools | Services. (for Windows 7.  This 
may vary depending on your Windows version and 
settings).

2 Stop all viewLinc Services: From the list of services, right 
click on the service (viewLinc Enterprise Server or 
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viewLinc Device Host, viewLinc Watchdog, and viewLinc 
POS Display), then from the pop-up menu, choose Stop. 

Q: What files are installed with viewLinc?

A: Most of the files installed as part of viewLinc are installed 
into one directory - by default, "viewLinc". During installation, 
administrators can change default file location and name. 

The default path to the files installed as part of viewLinc is 
C:\Program Files\Veriteq Instruments\viewLinc. You can also 
move database files to another location on your network.

The viewLinc installer also creates a program group, Veriteq 
Instruments, in the Start menu: C:\Documents and 
Settings\All Users\Start Menu\Programs\Veriteq Instruments. 
During installation, the viewLinc installer puts shortcuts to 
both the viewLinc login page and default viewLinc Help home 
page in the Veriteq Instruments program group.

During installation, the viewLinc installer also puts shortcuts 
to both the viewLinc login page and default viewLinc Help 
home page for the administrator who installed viewLinc: 
C:\Documents and Settings\<administrator_profile>\Start 
Menu\Programs\Veriteq Instruments. 

While running viewLinc, you can transfer device data (in an 
.spl file) from the device to a user-specified location. These 
.spl files are saved to a location specified by the user. A 
typical .spl file for a two-channel device is about 85KB.

viewLinc creates Event Logs which can be viewed from 
within the application. This data is stored in the installation 
directory.
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Q: My network uses a combination of Vaisala Veriteq  devices and 
300 Series Transmitters. How can I add them quickly?

A: To add multiple transmitters or a combination of devices 
and transmitters at one time, create a .txt definitions file with 
one device or transmitter defined per line. Add fields to 
identify the device class and device properties (separating 
each field with a tab).

To set vcom type devices (Vaisala Veriteq devices), define 
the com port number to which your device is connected. For 
example:

vcom   com_port=101

vcom   com_port=102

vcom   com_port=103

To set hmt330 type devices (300 Series Transmitters), define 
the following:

• sample_rate = the internal sample rate of the device

• timeout = the timeout for communication events

• connection = the type of connection, comport or tcp

• com_port = a com port number to which your device is 
connected (values for comport connections are user-
defined)

• ip_address = the IP device address of your devices (tcp 
connection)

• ip_port = the tcp port (values for tcp connections, 
ip_address and ip_port, are user-defined)

• Common values for both tcp and comport connections:

• sample_rate = 10s, 90s (default), 12m, 2h, 12h, 2d, 
or 12d

• Optional values for comport connection:

• baud = 300, 2400, 4800, 9600, 19200 (default), 57600, 
or 115200

• stopbits = 1(default) or 2

• databits = 7 or 8(default)

• parity = odd, even or none(default)
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For example:

Q: How do you add IP addresses for devices? 

A: You don't. However you do assign IP addresses to your 
communication devices. Because viewLinc communicates 
using COM ports, attaching devices to the network using 
Ethernet/IP addresses requires the use of a networking 
device. vNet or Digi devices create virtual COM ports that 
allow devices to communicate with viewLinc using Ethernet. 
We recommend that you do not use dynamic IP address for 
your device; instead, use a reserved or static IP address 
(obtained from your IT department). IP addresses are 
assigned to vNet or Digi devices during driver configuration. 
Refer to the Vaisala Veriteq Quick Start Guide for vNet or Digi 
devices for installation instructions. For more about vNet, see 
www.vaisala.com/lifescience-hitech. For more about Digis, 
see www.digi.com.   

Q: How does viewLinc know which devices (with attached devices) 
are assigned to it? 

A: It doesn't. Your network devices aren't 'assigned' to 
viewLinc; rather, viewLinc monitors the network for devices 
attached to COM ports. As mentioned, viewLinc software 
communicates via COM ports. Installing a network device  
creates virtual COM ports which are monitored by viewLinc. 

To see which COM ports (virtual or other) are assigned to a 
vNet or Digi device, use Device Manager: 

1 Open Device Manager (From Start, choose Control 
Panel | Administrative Tools | Computer Management. 
Device Manager is on the left hand side).

2 Once Device Manager is open, expand Ports (COM & 
LPT) to see which COM ports are connected to which 
devices. By default, vNet devices are named CDL-VNET-
P - model name; Digi devices are named Digi xxxxx 
(where x is the serial number of the device). 
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3 For more detail, in Device Manager, under Multiport 
serial adapters, right-click the device in question. Choose 
Properties, select the Advanced tab, and click on the 
properties button. On the left will be a list of the COM 
ports used for this device.

To see which devices are being controlled by viewLinc, see 
the System tab.

Q: I'm using vNet/Digi devices to connect my devices to the net-
work. I want to move my device from one location to another 
within the same subnet. What do I need to do?

A: If you've used a reserved or static IP address for your 
device (as recommended) and are moving your device from 
one location to another within the same subnet, here are the 
steps to follow:

1 Pause alarming on the device. (You may experience 
communication alarms while performing these steps if 
you do not pause alarming).

2 Unplug the vNet or Digi device from the network (with 
devices still attached). 
Note: You do NOT need to uninstall the Digi RealPort 

software from the viewLinc Server machine. In 
fact, doing so will potentially cause problems 
when you reattach the Digi to the network.

3 Move the device to another location.

4 Plug the device into the network again. 

5 Resume alarming. viewLinc should be able to reconnect 
with the device and allow you to see the devices.

Q: I'm using vNet/Digi device to connect my devices to the net-
work. I want to move my device from one subnet to another. What 
do I need to do?

A: If you've used a reserved or static IP address for your vNet 
or Digi device (as recommended) and you're moving your 
device from one location to another in a different subnet, 
there are several configuration steps:

1 Pause alarming. (You may experience communication 
alarms while performing these steps if you don’t pause 
alarming).
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2 You do NOT need to uninstall the device software from 
the viewLinc Server machine; but, you do need to make 
some configuration changes:

• Reserved IPs: Remove the reservation from the DHCP 
scope for the original subnet and create a new 
reservation in the DHCP scope for the new subnet. 
Proceed to step 6.

• Static IPs: With the vNet or Digi device still connected 
at its original location, log into the vNet or Digi web 
interface. In the address bar of a web browser, type the 
IP address of the device. (The IP of your device can be 
found using Device Discovery, if you are on the subnet 
as the device.)

• At the login screen, login as 'root' user and supply 
the password. The default password is 'dbps'. If 
you have not changed the password, use the 
default. 

• From the navigation bar, choose Network. In the 
Network Configuration screen, enter the new IP 
address, subnet mask and gateway for the new 
subnet. Click Apply.

• Reboot the device.
3 Move the device to its new location.

4 Configure viewLinc to look for the device in this new 
subnet. On the viewLinc machine, from Device Manager 
| Multiport Serial Adaptors, right click on the row for your 
device.

5 From the Properties screen, choose Advanced | 
Properties | Network.

6 From the Network screen, enter the network settings to 
reflect the device’s new IP address. Click OK.

7 Resume alarming. viewLinc should be able to connect to 
the device and allow you to see the devices.

If viewLinc can't connect to these devices or this device after 
performing the above steps, there may be a port blocked on 
the router connecting the subnets. Try the following:

1 Determine if the device in the new subnet is accessible 
from the viewLinc computer. From a command prompt on 
the viewLinc computer, type ping <IP address>. If there 
are successful responses to the ping, this test will prove 
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that routing exists between the subnets. Go to the next 
test.

2 For Digi devices:

a In the command prompt, type telnet <IP address>. If 
you get a login prompt, this test will prove that the de-
vice is able to respond to requests. Hit "Ctrl+C" to 
abort the login. Go to the next test.

b In the command prompt, type telnet <IP address> 771. 
If you get an error message (and the previous tests 
were successful) then Port 771 is being blocked be-
tween the local computer and the device. This port 
must be opened before the device can be used with 
Vaisala software. This port may be blocked by network 
devices (such as routers, firewalls or layer 3 switches) 
or PC software (such as the Microsoft Windows Fire-
wall, 3rd party firewalls, or security software suites). 
Unblock this port.

A successful connection is indicated by sets of three 
(3) horizontal lines ( ...) appearing on your 
screen. Note that one set of lines will appear every 10 
seconds.

Q: Why can’t I login to viewLinc despite using the correct user-
name and password?

A: Ensure the service “viewLinc Enterprise Server” is 
running. In Windows Control Panel, choose Administrative 
Tools | Services, then find “viewLinc Enterprise Server” on 
the list and right-click to Start. (If Enterprise Server isn’t 
running you cannot view the Login screen).

Q: I'm getting communication alarms in viewLinc. I think my net-
work device or device has stopped responding. What do I do?

1 A: Ensure your devices are plugged in.

2 Ensure your network device is connected to a power 
supply and the power supply is plugged in. On a Digi or 
vNet device, the power light on the front of the device 
should be solid red.

3 Ensure the device is connected to and communicating 
with the network. Try to ping the device by typing the 
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following at a command prompt: ping <IP address 
of the device>. 

4 If there is communication between the device and the 
network, check that the Vaisala-supplied cable 
connecting the device to the device is connected 
properly. If the light on the cable is solid red, there is a 
problem with the network device or device cable. Ensure 
your device has been configured to use RealPort (see 
www.vaisala.com/lifescience-hitech for more). If this still 
doesn’t fix the problem, go to step 6.

5 If the light on the cable is working correctly but you are 
still getting communication alarms, go into Device 
Manager on the viewLinc computer and ensure the 
device is still installed. Under the Multiport serial adaptor 
category in Device Manager, you should see an entry for 
the device with the address you configured. If you don't 
see this, try connecting another working device, or 
reinstall the device.

6 If the light on the cable is not working properly, open 
vLog and determine if the cable can communicate with 
the device. If there is a problem with the device 
communicating with the graphing application, it is likely 
the device or device cable is not functioning properly. Try 
connecting the device to a new device, or to a computer 
using USB, and see if you can connect to it in vLog. 

Q: I'm in viewLinc and trying to transfer device files to a network 
location but it isn't working. What do I do?

A: First, ensure you are using the full network path to the 
network directory (for example, \\ComputerName\etc.), not a 
mapped drive letter. Also, ensure that the account that's 
running viewLinc has write permissions to the folder where 
you're attempting to transfer the device files. The account 
that's running viewLinc was set during installation. See 
information on installing viewLinc in Chapter 1 of this guide, 
or online help.
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Q: I've made some changes in viewLinc, such as new thresholds 
and device descriptions, but they're not showing up. What's 
wrong?

A: Location information is updated and refreshed depending 
on the refresh rate set in viewLinc. Click the Refresh button 
in viewLinc, or determine the refresh rate viewLinc is using 
and wait the allotted time. 

Q: How does viewLinc select colors for reports?

A: When location line colors are set to ‘Auto’ viewLinc  
assigns the next free color from a built in palette of colors 
Colors are selected in the following order/sequence:

a Black (0, 0, 0)

b Red (255, 0, 0)

c Green (0, 128, 0)

d Orange (255, 165, 0)

e Blue (0, 0, 255)

f Yellow (255, 255, 0)

g Purple (128, 0, 128)

h Brown (150, 75, 0)

i Gray (128, 128, 128)

j Maroon (128, 0, 0)

k Lime (0, 255, 0)

l Tomato (255, 99, 71)

m Azure (30, 127, 255)

n Amber (255, 204, 0)

o Byzantium (112, 41, 99)

p Bronze (205, 127, 50)

q Silver (192, 192, 192)

r Crimson (220, 20, 60)

s Emerald (80, 200, 120)

t Coral (255, 127, 80)

u DeepSkyblue (0, 191, 255)

v Ecru (205, 178, 128)



Appendix: FAQs & Troubleshooting

146 © 2012 Vaisala Canada Inc

w Eggplant (97, 64, 81)

x Buff (240, 220, 130)

Q: If I wish to back up the files associated with viewLinc, what are 
their locations and file sizes?

A: viewLinc configuration text files: <installdir>\config\* (small 
text files)

viewLinc security keys for https: <installdir>\config\keys\* 
(small binary files)

viewLinc operational configuration:  
app_data_root\db\Viewlinc.sqlite (up to 100MB on very large 
systems)

viewLinc historical data files: app_data_root\db\hist\YYYY-
MM\* (up to 10GB per month on very large systems)

viewLinc event logs: app_data_root\log\Events\Events-
YYYY.sqlite (up to 100MB per year on very large systems)

viewLinc Repository files, uploaded dashboard images, 
report logos etc: app_data_root\db\repository\images\*.* 
(under 5 MB)

Note: It is recommended that all viewLinc services be 
stopped before performing a backup.

Q: How can I connect via wireless or ethernet with 300 series 
devices?

A: Internal LAN-1 Module (Ethernet): Allows single PTU300*, 
HMT330, DMT340 or MMT330 transmitter to connect to the 
viewLinc host computer via standard TCP/IP Ethernet 
network. LAN-1 Module is internally powered by the 
Transmitter.

Internal WLAN-1 Module (802.11b/g WIFI): Allows single 
PTU300*, HMT330, DMT340 or MMT330 device to connect 
to the viewLinc host computer via standard 802.11b/g 
wireless networks. WLAN-1 Module is internally powered by 
the Transmitter.

Single port Digi Device (Ethernet): Allows single PTU300, 
HMT330, DMT340 or MMT330 device to connect to the 
viewLinc host computer via standard TCP/IP Ethernet 
network. Requires installation of Digi device drivers 
(included) and configuration of virtual COM ports on viewLinc 
host computer.  Digi Device available with 802.3af Power 
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over Ethernet (PoE) (Optional) Digi Device  9-30VDC 
powered (AC adapter included). Requires transmitter 
configured with DB9 serial cable. Requires DB9-serial cable 
connection between Digi Device and Transmitter.

Multi-port Digi Device (Ethernet): Allows multiple  PTU300, 
HMT330, DMT340 or MMT330  devices to be connect to the 
viewLinc host server via standard TCP/IP Ethernet network. 
Requires installation of Digi device drivers (included) and 
configuration of virtual COM ports on viewLinc host 
computer.  Allows for multiple  PTU300, HMT330, DMT340 or 
MMT330  to connect to the host server through a common 
TCP/IP network interface module. Digi Device available with 
802.3af Power over Ethernet (PoE) (Optional). Digi Device is 
9-30VDC powered (AC adapter included) Requires 
transmitter configured with DB9 serial cable. Requires DB9-
serial cable connection between Digi Device and Transmitter.

Single port Digi Device (802.11b/g WIFI): Allows single 
PTU300, HMT330, DMT340 or MMT330 device to connect to 
the viewLinc host computer via standard 802.11b/g wireless 
networks. Requires installation of Digi device drivers 
(included) and configuration of virtual COM ports on viewLinc 
host computer. Requires transmitter configured with DB9 
serial cable. Digi Device is 9-30VDC powered (AC adapter 
included)

Multi-port Digi Device (802.11b/g WIFI): Allows multiple  
PTU300, HMT330, DMT340 or MMT330 devices to be 
connect to the viewLinc host server via standard 802.11b/g 
wireless networks. Requires installation of Digi device drivers 
(included) and configuration of virtual COM ports on viewLinc 
host computer. Allows for multiple dataloggers to connect to 
the host server through common 802.11b/g wireless 
networks. Requires transmitter configured with DB9 serial 
cable. Digi Device is  9-30VDC powered (AC adapter 
included). 

Note: PTU300 can only support WLAN-1 and LAN-1 
modules when no datalogger modules are 
installed.

Q: How do I enable or disable HTTPS?

A: Set the https_port to 0 in the viewlinc.cfg file, or select the 
port during installation.
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Q: How do I upgrade from viewLinc 3.6/3.7?  How does viewLinc 
upgrade my data for use in viewLinc 4.0?

A: viewLinc will automatically detect your existing version 
and convert your data.  This is done transparently when you 
install viewLinc 4.0.  The data is treated as follows:

1 Zones are created based on the Zones structure in 3.6. 
They are created as a top-level zone. A top-level zone 
called ‘Unassigned’ is created for the unassigned zone

2 Locations are created for all active channels. The 
location name is copied from the channel preferred 
description (Alias or device description, depending on 
the system preference). Duplicate channels in multiple 
zones will be dropped. 

3 If 3.6 has restricted users configured, then ACL’s are 
created according to the following procedure:

a The user ‘Everyone’ will have ‘View’ permissions on 
the System node with no inheritance

b Restricted users who have been allocated a zone will 
have an ACL created on the new zone with their per-
mission level

c Restricted users who have been allocated a channel 
will have an ACL created on the new location with their 
permission level

d Users will also be placed in groups according to their 
pemissions

e Regular Users – ACL for Acknowledge Alarms

f Operators  - ACL for Configure Custom Thresholds

g Supervisors – ACL for Configure Alarms

h Everyone – View

4 Users with Full Control will be added to the 
‘Administrators’ group

5 Thresholds configured on active channels will be 
attached to the new locations

6 Reports will be upgraded to use the new locations/zones

7 Floormaps (3.7) will be upgraded to the dashboards and 
will use the new locations

8 POS displays will be upgraded to use the new locations
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9 Device ACLs will be created for the Administrators group 
only

For more help with any of these issues, contact Vaisala 
Canada at 1-866-861-3388 or vaisalasupport@veriteq.com. 
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Numerics
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adding 41
installing 8
IP address 42
output quantities 62
See also System Requirements
swapping 43

A
acknowledge an alarm 75, 95, 96
active alarms

viewing 74
adding

comments to alarm notifications 84
multiple devices 139

adding comments
to event logs 111

administrator’s road map 4
alarm templates

creating 80
editing 50

alarm trigger 80
alarms 77

acknowledging 75, 94, 95, 96
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viewing 74
changing email contents for 50
color codes 81
commands 84
communication 78, 90

commands 84
comments in 84
disabling 92
editing 92
email notifications 82
pausing 97

pop-up notification 81
troubleshooting 143

device 79, 93
configuration 79

device calibration alarms
defined 79

devices 79
email notifications 82

editing device alarms 94
email notifications 80
email settings 49
multiple notifications 80, 83
pausing 97
templates 81
threshold 78

comments in 84
deactivating 89
disabling 89
editing 88
email notifications 82
multiple notifications 83, 86
pausing 97
pop-up notification 81
setting 87

threshold condition template 85
tree hierarchy 80
validation 79

aliases, setting 55, 56
android devices

supported 132
apple iOS 132
applications

running when alarm triggered 84
average value 121

B
background color 81
blackberry devices

supported 132
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browsers
supported 6

C
calibration alarms 79
celsius, showing temperatures in 56
channel description

defined 65
editing 46

channel number 65
channels

aliases 56
editing properties 46
linking 32
properties 46
unlinking 32

clear unit preferences 48
cloning a report 123
color

selecting for alarms 81
selecting for reports 122

color palette 145
columns

hiding and showing 36
ordering 32

COM Ports
viewing 140

commands
alarms 84

comments
adding to alarms 84
adding to event logs 111
for email messages 58
preconfigured 58, 84
viewing 111

communication alarms
adding comments to 84
adding email notifications 82
adding pop-up notification 81

color codes 81
defined 78
disabling 92
editing 92
pausing 97
setting 90
templates 81
troubleshooting 143

configuration alarms
defined 79

contact schedules
creating 53

creating
alarm templates 81
preconfigured comments 84
reports 123

customer support vii

D
data transfers

immediate transfer 128
scheduled transfer 126

deactivating
devices 44
threshold alarms 89
transfer schedules 129
zones 34

definition file for devices 139
device configuration alarms

defined 79
devices

adding 40, 41
adding multiple 139
alarms 93
aliases 55
calibration alarms 79
configuration alarms 79
deactivating 44
definitions file 139
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descriptions 55
discovering 40
editing aliases 45
editing properties 45
removing 44
swapping 42

Digi devices
installation of viewLinc with 11–15
moving location of 141
RealPort driver installation 12
troubleshooting 140, 141

disabling
communication alarms 92
threshold alarms 89

discovering
Vaisala Veriteq Loggers 40
vNet devices 10

drivers
RealPort 10, 12
USB cable 13

E
editing

communication alarms 92
device aliases 45
device and channel properties 45
email templates 51
logger alarms 94
threshold alarms 88
zones 30

email
settings 49
templates 50

macros 52
email notifications 80

in alarms 82
event logs 109–113

adding comments to 111
adding custom events 112

exporting 113
printing 112
saving 113
viewing 110
viewing comments 111

Excel reports 117, 118, 120
exporting

event logs 113

F
fahrenheit, showing temperatures in 56
FAQ 137
files

backing up 146
installed with viewLinc 138

Firefox
versions supported 6

G
getting help vii
graphs

viewing 65, 66
groups

creating 101
deactivating 102
reactivating 102

H
hardware requirements 5
help

technical support vii
historical data 2, 115, 125

purpose of 116
viewing 65, 66

host, installing 14
hosts

adding 48
HTTPS

disabling 147
enabling 147
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I
indicators, color 81
installation

300 Series Transmitters 8
Administrator’s Road Map 4
Digi RealPort driver 12
host 14
viewLinc 8, 15
vNet RealPort driver installation 10

installing viewLinc 8
Internet Explorer

versions supported 6
IP addresses

300 Series Transmitters 42
iPhone 132

L
launching applications or devices 80
locations

aliases 55
changing unit preference 48
opening 65, 66
reading graphs 73
screen 63
searching for 31
unlinking 34

logger alarms
adding comments to 84
adding email notifications 82
adding pop-up notification 81
color codes 81

logger validation alarms
defined 79

loggers
adding

300 Series Transmitters 41
alarms

editing 94
templates 81

aliases 45, 56
channel descriptions 46
descriptions 45, 56
transfer schedules 126
transfers 128

troubleshooting 144
validation alarms 79

logging in
problems with 143

login screen 15
logs, event. See event logs.

M
macros

using in email templates 52
mail server settings 49
maximum value 121
mean kinetic temperature (MKT) 121
measurement units 56
microsoft excel

exporting logs to 113
viewLinc event logs and 113

minimum value 121
mobile devices

supported 132
Mobile UI 131, 132

about 132
acknowledge alarms with 134
pause or resume alarming with 134
working with 132

Mozilla Firefox
versions supported 6

multiple alarm notifications 83

N
new in viewLinc 4.0 17
notifications

calibration 79
multiple 80
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O
opening large popup trend view 65, 66
output quantities 62

P
passwords

reconfirmation after session expiry 
17, 57

pausing alarms 97
PDF reports 117, 118, 120
permissions

about 100
permissions, user 52
popup trend views

acknowledging alarms from 75
opening 71
reading 73
viewing 75

pop-ups
for alarms 79

preconfigured comments 84
preferences

about 55
printing

reports 123
privileges, user 52

R
reactivating

users 55
reading

threshold values 74
reading graphs

in large popup trend view 73
real-time graphs 73
replacing devices 42
reports 115–123

about 116
alarm history 117

cloning 123
color 122
colors 145
creating 123
deleting 124
Excel 117, 118, 120
generating 116, 117, 118
locations history 119
PDF 117, 118, 120
printing 123
types 116

road map 4
run commands

for alarms 84

S
sample count 121
scheduled data transfer

deactivating 129
disabling 129
editing 128
scheduling 126

secure SMTP 50
security

levels 52
serial ports 4

installation of viewLinc with 13–15
server requirements 6
services 137
session expiry 17, 57
session expiry time

setting 57
setting

alarm templates
color code 81

communication alarms 90
threshold alarms 87

setting up
installing 8
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road map 4
Settings. See system settings
showing deactivated transfers 129
spreadsheets, event log data in 113
standard deviation 121
statistics intervals 121
statistics settings 121
status bar, defined 65
stopping viewLinc 137
subnets

troubleshooting 142
support, technical vii
supported browsers 6
swapping devices 42
system requirements 5
system settings 39–57

T
tabs 63
technical support vii
templates

creating 81
editing 50
using macros 52

threshold alarms
adding comments to 84
adding email notifications 82
adding pop-up notifications 81
color codes 81
deactivating 89
defined 78
disabling 89
editing 88
multiple notifications 86
pausing 97
setting 87
templates 81, 85

threshold summary, defined 65
threshold values, reading 74

thresholds
creating and editing 37
creating condition templates 85

timestamp 65
to unlink a channel 33
transfer schedules 126

creating 126
deactivating 129
disabling 129
editing 128

transferring data
immediately 126, 128
showing deactivated transfers 129

transfers
about 126

transmitters
adding 41
installing 8
output quantities 62
See also System Requirements
supported 137

troubleshooting 137–149
subnets 142

U
unit preferences

locations 48
units, temperature 56
upgrading from earlier version 14, 148
USB ports 3
user accounts

editing 54
logging in 15

users
contact schedules 53
creating 102
deactivating 54
editing 54
passwords 54
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using color
for alarms 81
for reports 122
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Vaisala Veriteq loggers

discovering 40
See also System Requirements

validation alarms
defined 79

viewing
active alarms 74
COM ports 140
event comments 111
locations 65, 66

viewLinc
backing up 146
browsers supported by 6
files installed with 138
installation 12

with Digi devices 11–15
with serial ports 4, 13–15
with USB 3
with vNet devices 9

logging in 15
security options 17, 57
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services 137
supported transmitters 137
turning off 137
upgrading from earlier version 14, 

148
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installation 13
vNet devices
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moving location of 141
RealPort driver installation 10
troubleshooting 140, 141

W
what’s new 17
windows services 137

X
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